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ABSTRACT 

 

In the present investigation, an attempt is made to develop a mathematical model of 

diabatic capillary tube. The mathematical model has been developed by using 

equations of conservation of mass, momentum and energy. We need to calculate both 

single phase and two phase length for predicting the length of diabatic capillary tube. 

Flow of refrigerants inside a capillary tube is a complex phenomenon and is further 

complicated by heat exchange region in case of diabatic capillary tube. The presence 

of heat exchange region causes a delay of vaporization. When the vaporization starts 

pressure falls sharply. Friction Factor also plays an important role in the pressure 

drop. Moody (1944) correlation is used to calculate the friction factor. McAdams et 

al. (1942) viscosity correlation has been used to evaluate the two phase viscosity of 

the refrigerant. Input parameters have been taken from the data of Mendoca et al. 

(1998). Further a geometric model is developed in Pro-E and the mesh is created in 

Ansys ICEM CFD and analysis is carried out in Ansys CFX which has three modules 

CFX-Pre, Solver and CFX-Post. 

Finally the results of mathematical model are validated with Ansys CFX and found to 

be in fair agreement.  
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d capillary tube internal diameter, m     

D coil diameter, m      

 suction line diameter, m 

 degree of subcooling, K 

e roughness height, m 

f friction factor 

G mass velocity, kg/m2/s 

L capillary tube length, m 

m mass flow rate, kg/s 

P pressure, Pa 

T temperature, _C 

 

Greek letters 

  viscosity, kg/m/s 

 density, kg/m3 

 

Subscripts 

hx heat exchanger 

in capillary tube inlet 

k condenser 

o evaporator 

out outlet 
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Condenser 

Compressor 

Evaporator 

Adiabatic 

Capillary 

Tube 

Chapter 1 

Introduction 

In this chapter, the capillary tubes, their classifications and the flow phenomena 

associated with capillary tube diabatic capillary tubes have also been discussed. The 

objectives of the proposed work have also been mentioned. 

1.1 Capillary tube and its classification 

In a vapour compression cycle, the refrigerant vapours emerging from the evaporator 

after producing the cooling effect enters the compressor. The compressor activates the 

refrigerant to high temperature and high pressure superheated vapours. These high 

temperature vapours get condensed inside the condenser. The saturated liquid refrigerant 

enters the capillary tube where the expansion pressure from high pressure to low pressure 

takes place. After expansion the refrigerant re-enters the evaporator and the cycle 

continues. 

Capillary is used as an expansion device in a 

refrigerant in low capacity vapour compression 

systems like domestic refrigerators, freezers, 

window type air conditioners etc. A capillary tube 

is a 1 - 6 m long tube of drawn copper with an 

inside diameter generally from 0.5 to 2 mm, 

which connects the outlet of the condenser to the 

inlet of the evaporator. The capillary tube has low 

cost and is simple in construction. The refrigeration 

 system employing capillary tube requires low starting torque motor as the pressure 

across the capillary tube equalizes. 

Depending upon the flow, the capillary tubes can be classified as follows: 

• adiabatic capillary tube and  

• diabatic capillary tube  

Fig. 1.1 Vapour Compression System 
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In adiabatic arrangement, the capillary tube is thermally insulated and the heat exchange 

with the ambient is negligible.  

 

 

 

 

 

 

 

 

 

 

 

 

In a diabatic flow arrangement, shown in Fig. 1.2., the capillary tube is bonded with 

the cold compressor suction line in a counter flow arrangement. Employing diabatic 

capillary tube in a refrigeration system results in higher refrigerating effect, thus, a better 

system performance is achieved. As shown in Fig. 1.2, the enthalpy of liquid refrigerant 

flowing in the capillary tube continuously falls in the single phase region as well due to 

heat exchange with the cold suction line of compressor. With the result the enthalpy of 

the refrigerant falls continuously throughout the capillary tube length. The presence of 

heat exchanger produces considerable subcooling in the liquid region, and consequently, 

causes a delay in flash point. Unlike adiabatic capillary tubes where the refrigerant 

temperature in the single phase region is constant, heat transfer to the suction line causes 

the temperature of refrigerant and, hence, the saturation pressure of the liquid refrigerant 

to fall. The reduction in saturation pressure causes a delay in the onset of flashing, and 

thus results, a longer single phase liquid length.  

Fig. 1.2 (a) VCS using diabatic capillary tube (b) P-h diagram 
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Recondensation 

The thermal contact between the capillary tube and the compressor suction line can be 

attained in two ways viz., lateral and concentric arrangement. The two arrangements are 

shown in Fig. 1.3. In lateral configuration, the capillary tube is bonded with the 

compressor suction line by means of a solder or brazing joint. Further, the copper tape is 

wound around the two bonded tubes so that the walls of the tubes could attain thermal 

equilibrium. In concentric arrangement, the 

capillary tube occupies the core of compressor 

suction line as shown in Fig. 1.3 (b). In the 

concentric arrangement, the capillary tube is 

surrounded by the cold vapors of the suction line 

emerging from the evaporator. Thus, the capillary 

tube is in direct contact with the vapors, a higher 

heat transfer from the capillary tube to the suction 

line vapors will take place. Therefore, the 

concentric arrangement is preferred over the lateral 

arrangement as the contact thermal resistance is 

smaller and a better system performance is 

achieved.  

Normally, the refrigerant temperature inside the 

capillary tube is higher than the refrigerant vapour 

temperature inside the suction line. Therefore,  

(a) 

(b) 

Fig. 1.3 (a) Lateral arrangement (b) Concentric arrangement 

Fig. 1.4 Flow pattern along with 
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earlier studies assumed the two-phase convective heat transfer coefficient to be infinite 

and based on condensation. In fact, as per the relative position of refrigerant flow inside 

the capillary tube-suction line heat ex-changer, it can be categorized into three different 

states: convective boiling, condensation, and liquid state. As can be seen from Fig. 1.4, 

the inlet and outlet region of the capillary tube-suction line heat exchanger is fully 

adiabatic and hence subcooled refrigerant entering the capillary can cause the flashing to 

occur due to strong pressure drop effect. This can be termed convective boiling in the 

tube. On the other hand, the flow pattern for two-phase refrigerant entering the tube 

within the adiabatic capillary tube inlet region is similar to that described for sub cooled 

inlet. When the refrigerant flows into the capillary tube-suction line heat exchange 

region, it loses heat to the suction line side, its quality decreases and at times the 

refrigerant can be in complete condensation state. Due to the strong heat transfer effect, 

the refrigerant quality may reduce to zero, leading the re-condensation phenomenon to 

occur. 

 

1.2 Objectives of the proposed work 

• To develop the numerical models for diabatic capillary tube using finite 

difference methods (FDM).  

• To develop same model using ANSYS CFX module. 

• To validate the developed numerical model with the developed ANSYS CFX 

module. 

 

 

 

 

 

 

 

 



5 

 

Chapter 2 

 

Literature Review 

 
The literature of diabatic capillary tubes can be grouped under two categories, viz. 

experimental investigation numerical investigations as shown in Fig. 2.1. Historically, 

tubes were sized in a number of ways e.g. empirically, by interpolation, extrapolation 

from previous experience of the capillary designers, or through charts produced by 

various agencies such as ASHRAE and commercial companies. 

Since the present work mainly deals in numerical part, focus will be more on 

numerical investigations. The experimental investigations have been reviewed just for the 

sake of validation of the models to be developed using FDM and ANSYS CFX module. 

 

 

 

 

 

2.1 Experimental Investigations 

The experimental investigations involve the experimental work conducted by 

different researchers to evaluate the performance of diabatic capillary tubes using 

different refrigerants. Table 2.1 shows some of experimental studies of various other 

researchers. 

Fig. 2.1 Organization of literature on diabatic capillary tube 
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The experimental work on diabatic capillary tubes was pioneered by Staeblar [20]. 

The capacity balance characteristics to determine the length of diabatic capillary tube for 

R-12 and R-22 were proposed. The characteristics curves were plotted for 1.067 mm 

capillary tube diameter at two condenser temperatures, 30 
o

C and 42.2 
o

C and evaporator 

temperatures ranging from -28.9 
o

C to -1.1 
o

C.  

 

Table 2.1 Experimental investigations on diabatic capillary tube 

author(s) 

(year) 
refrigerant(s) range of parameters 

characteristics/ 

correlations 
remarks 

Staeblar[20] 

(1948) 

R-12 

R-22 

d = 0.787 to 1.397 mm 

To = -28.9 
o
C to -1.1 

o
C 

Tk = 30 
o
C and 42.2 

o
C 

capacity balance length is determined 

Bolstad and Jordan[5] 

(1949) 

R-12 

 

d = 0.66 to 1.397 mm 

L = 1.83, 3.66, 5.49 m 

Pk = 827.4, 965.3, 1103.3 kPa 

Po = 103.4 kPa 

temperature and pressure 

profile 

friction factor 

relations 

Pate and Tree[16] 

(1984) 
R-12 

d = 0.71 mm 

Ds = 6.35 mm 

Lhx = 2.086m 

L = 2.953 m 

temperature and pressure 

profiles 

observed metastable 

flow in adiabatic 

capillary tube but not 

in diabatic 

Khan et al.[ 11] 

(2007) 
R-134a 

p = 40, 60, 80 mm 
Tk = 40 _C 
DTsub = 10 _C 

m = 8.28 kg/h 
d = 1.07 mm; 

Comparison of the results of 
spiral capillary tube with 
straight capillary operating 
under similar conditions 

Homogeneous two-
phase flow 

 

Bolstad and Jordan[5] investigated capillary tubes of diameters ranging from 0.66 

mm to 1.397 mm for three inlet pressures of 827.4 kPa, 965.3 kPa and 1103.3 kPa. It was 

concluded that the effect of changes in evaporator pressure on the mass flow rate of R-12 

was insignificant. The refrigerant temperature fell rapidly in the heat exchange region as 

the suction line of compressor is at a lower temperature than the capillary tube while the 

pressure fell linearly up to certain length and as the flashing began the drop in pressure is 

accelerated. Finally, friction factor characteristics, demarcating the laminar and turbulent 

regimes, were drawn for the flow of water inside the same capillary tube. Pate and Tree 

[16] analyzed the diabatic flow of R-12 through the straight capillary tube with air 

flowing in the suction line in counter flow direction forming an open loop. The same tube 

acted as an adiabatic capillary tube as the air flow was shut-off. It was found that the 

behavior of capillary tube with heat transfer was considerably different from that of an 

adiabatic capillary tube. When comparing the pressure profiles of diabatic capillary tube 

with adiabatic capillary tube, the higher degree of inlet subcooling resulted in a greater 

mass flow rate and a steeper pressure profile. It was due to the increased subcooling 
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causing the delay in vaporization and a shorter two-phase flow region was resulted. This, 

in turn, resulted in less flow restriction and a higher mass flow rate.  

 

2.2 Numerical Investigations 

Table 2.2 shown below shows the work of different authors on diabatic capillary 

tubes by using numerical techniques. 

 

Table 2.2 Numerical investigations on diabatic capillary tube 

author(s) 
(year) 

refrigerant(s) range of parameters 
characteristics/ 

correlations 
methodology 

Valladares et al. 

[24] 

(2002) 

Refrigerants and 

mixtures 
- 

one dimensional steady and 

transient numerical 

simulation 

homogeneous two-

phase flow model, 

finite volume method 

Valladares et al. 

[25] 

(2002) 

Refrigerants and 

mixtures 
- 

parametric study for 

concentric diabatic capillary 

tube 

validation of numerical 

model with data of 

previous researchers 

Xu and Bansal[27] 

(2002) 
R-134a 

d = 0.66 mm; Tk = 48 
o
C 

Ds = 6.6 mm; Lhx = 1.0 m; 

To = -15 5 
o
C; ∆Tsub = 1 

o
C 

mathematical modeling, 

validation and parametric 

study 

finite volume method 

Bansal and Xu[2] 

(2003) 
R-134a 

d = 0.66 mm Lhx = 1.0 to 2.5 

m; Tk = 32 to 47 
o
C 

To = -10 to -20 
o
C 

∆Tsub = 1,2 and 3 
o
C 

parametric study 

 
finite volume method 

Valladares[26] 

(2004) 
R-407C - numerical simulation 

review of his own 

numerical models 

 [24-25] 

Chen and Gu[6] 

(2005) 
CO2 

d = 1.85 mm 

Tin = 45 
o
C 

Tout = -5 to 10
 o
C 

pressure, temperature 

enthalpy and entropy profiles 
finite volume method 

Bansal and Yang[3] 

(2005) 

R-134a 

R-600a 

d = 0.867 mm; Ds = 6.6 mm; 

Lhx = 1.0 m; Tk = 42 
o
C; 

To = -13 
o
C; ∆Tsub = 1 

o
C 

parametric study finite volume method 

Bansal and Yang[4] 

(2005) 

R-134a 

R-600a 

d = 0.867 mm; 

Ds = 6.6mm; Lhx=1 m 

Tk = 42 
o
C, 

To = -13 
o
C 

∆Tsub = 1 
o
C 

proposed a thermodynamic 

equation to determine the 

pressure drop per unit length 

during re-condensation 

finite difference 

scheme and successive 

substitution method 

Khan  et al.[11] 

 [2007] 
R-134a 

p = 40, 60, 80 mm 
Tk = 40 _C 
DTsub = 10 _C 

m = 8.28 kg/h 
d = 1.07 mm 

Comparison of the results of 
spiral capillary tube with 
straight capillary operating 
under similar conditions 

Homogeneous two-phase 
flow 

 

 

Bansal and Rupasinghe[17] developed an empirical model for sizing capillary tubes.  

This paper presents an empirical model that has been developed to size adiabatic and 

non-adiabatic capillary tubes for small vapour compression refrigeration systems, in 

particular, household refrigerators and freezers. The model is based on the assumption 

that the length of a capillary tube is dependent on five primary variables, namely the 

capillary tube inner diameter, the mass flow rate of the refrigerant in the capillary tube, 
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the pressure difference between highside and lowside, the refrigerant subcooling at 

capillary inlet and the relative roughness of the capillary tube material. The model is 

validated with previous studies over a range of operating conditions and is found to agree 

reasonably well with the experimental data for HFCI34a. 

 

Sami, Maltais and  Desjardins[19] studied the Influence of Geometrical Parameters on 

Capillary Behavior with New Alternative Refrigerants. 

In this paper, the experimental data obtained on capillary tube behavior, using various 

new alternatives under different geometrical parameters are presented and analyzed. 

Capillary geometrical parameters include length, diameter, as well as entrance conditions. 

The results clearly showed that the pressure drop across the capillary tube is significantly 

influenced by the diameter of the capillary tube, inlet conditions to the capillary and 

refrigerant type. The data demonstrated that the capillary pressure drop decreases with 

the increase of the capillary diameter and that alternatives in general experience higher 

pressure drop than that of R-22. 

 

Wongwises, Songnetichaovalit, Lokathada, Kritsadathikarn, Suchatawat and Pirompak 

[23] did a comparison of the flow characteristics of refrigerants flowing   through 

adiabatic capillary tubes. 

This paper presents theoretical comparison of the flow characteristics of many pairs 

of refrigerants flowing through adiabatic capillary tubes. The two-phase flow model 

developed was based on homogeneous flow assumption. Two-phase friction factor was 

determined from Colebrook correlation. The viscosity model was also based on the 

recommendations from the previous literature. For all pairs, numerical results showed 

that the traditional refrigerants consistently gave lower pressure drops for both single-

phase and two-phase flow than the environmentally acceptable alternative refrigerants 

which resulted in longer tube lengths. 

 

Sinpiboon and Wongwises[22] did numerical investigation of refrigerant flow through 

diabatic capillary tubes. 
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A mathematical model is developed to study flow characteristics in diabatic capillary 

tubes. The theoretical model is based on conservation of mass, energy and momentum of 

fluids in the capillary tube and suction line. The mathematical model is categorized into 

three different cases, depending on the position of the heat exchange process. The first 

case is considered when the heat exchange process starts in the single-phase flow region, 

the second case is determined when the heat exchange process starts at the end of the 

single-phase flow region, and the last case is considered when the heat exchange process 

takes place in the two-phase flow region. A set of differential equations is solved by the 

explicit method of finite-difference scheme. The model is validated by comparing with 

the experimental data obtained from previous works. The results obtained from the 

present model show reasonable agreement with the experimental data. The present 

diabatic capillary tube model can be used to integrate with system models working with 

alternative refrigerants for design and optimization. 

 

Zhang and Ding[9] to approximate analytic solutions of adiabatic capillary tube. 

Approximate analytic solution of capillary tube is valuable for theoretical analysis 

and engineering calculation. In this work, two kinds of approximate analytic solutions of 

adiabatic capillary tube have been developed. One is the explicit function of capillary 

tube length. Another is the explicit function of refrigerant mass flow rate. In these 

solutions, the choked flow condition is taken into account without iterative calculations. 

The approximate predictions are found to agree reasonably well with experimental data in 

open literatures. 

 

Bansal and Yang[4] developed a model for HFC-134a and HC-600a to study heat transfer 

phenomena in non-adiabatic capillary tubes. 

A numerical simulation model for lateral capillary tube-suction line heat exchangers 

is presented to analyze its performance characteristics in small vapour compression 

refrigeration systems (e.g. domestic refrigerators). Appropriate heat transfer correlations 

have been used to illustrate the heat transfer phenomena inside the tubes. Some 

convergence problems were encountered during the execution of the model when lower 

vapour temperature inside the suction line caused the two-phase refrigerant inside the 
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capillary tube to re-condense within the heat exchange region. The modeling was 

performed with two refrigerants, namely HFC-134a and HC-600a. Further, a simple 

theoretical equation has been developed to express the re-condensation phenomenon in 

diabatic capillary tubes. 

 

Yang and Bansal[3] presented Numerical investigation of capillary tube-suction line heat 

exchanger performance. 

This paper presents the numerical results of the effect of different parameters on the 

performance of capillary tube-suction line heat exchangers (CT-SLHX), including 

condensing and evaporating temperatures, degrees of subcooling and superheat, tube 

diameter, tube length, and refrigerant flow inlet quality. The heat transfer rate from the 

capillary tube to the suction line has been simulated for two environmentally friendly 

refrigerants, namely HFC-134a and HC-600a. The simulation model also postulates the 

situation where heat may be transferred from capillary tube to the ambient air, before 

entering the CT-SLHX. 

 

Bansal and Rupasinghe[18] developed an homogenous model for adiabatic capillary 

tubes. 

This paper presents a homogeneous two-phase flow model, CAPIL, which is 

designed to study the performance of adiabatic capillary tubes in small vapour 

compression refrigeration systems, in particular household refrigerators and freezers. The 

model is based on the fundamental equations of conservation of mass, energy and 

momentum that are solved simultaneously through iterative procedure and Simpson's 

rule. The model uses empirical correlations for single-phase and two-phase friction 

factors and also accounts for the entrance effects. The model includes the effect of 

various design parameters, namely the tube diameter, tube relative roughness, tube 

length, level of subcooling and the refrigerant flow rate. The model is validated with 

earlier models over a range of operating conditions and is found to agree reasonably well 

with the available experimental data for HFC-134a. 
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Valladares[24] did numerical simulation of diabatic capillary tubes. Part I: Mathematical 

formulation and numerical model. 

A detailed one-dimensional steady and transient numerical simulation of the thermal 

and fluid-dynamic behavior of capillary tube suction line heat exchangers has been 

carried out. The governing equations (continuity, momentum, energy and entropy) for 

fluid flows, together with the energy equation in solids, are solved iteratively in a 

segregated manner. The discretized governing equations in the zones with fluid flow are 

coupled using a fully implicit step-by-step method. An implicit central difference 

numerical scheme and a line-by-line solver were used in solids. A special treatment has 

been implemented in order to consider transitions. All the flow variables (enthalpies, 

temperatures, pressures, mass fractions, heat fluxes, etc.) together with the 

thermophysical and transport properties are evaluated at each point of the grid in which 

the domain is discretized. The numerical model allows analysis of aspects such as 

geometry, type of fluid, critical or non-critical flow conditions. 

 

Khan, Kumar, Sahoo[11] developed a model based on FDM to refrigerant mass flow rate 

Khan et al.[11] presented the performance of R-134a through a diabatic capillary tube 

with lateral configuration. The paper was divided into two sections: (1) an experimental 

investigation of straight and helical diabatic capillary tubes and (2) a numerical 

investigation of the straight diabatic capillary tube. In the experimental investigation, the 

effects of parameters such as capillary tube diameter, capillary tube length, coil pitch, and 

inlet subcooling on the refrigerant mass flow rate through a diabatic capillary tube were 

studied. In addition to the parameters mentioned above, the mass flow rate through a 

diabatic helical capillary tube was also found to be a function of suction-line inlet 

superheat and heat exchange length. The suction-line inlet superheat in the present 

investigation is not a controlled parameter. A comparison of the results of diabatic helical 

capillary and adiabatic helical capillary tubes was also made. On the basis of acquired 

experimental data, a correlation to predict the refrigerant mass flow rate was proposed. 

It was found that the predictions of the proposed correlation are within ±5% agreement 

with the experimental data. In the numerical investigation, a mathematical model was 

developed by applying laws of conservation of mass, momentum, and energy to a straight 
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diabatic capillary tube. These differential equations were solved numerically using a 

finite difference method. The developed model was validated with experimental data 

from previous and present research.  

 

Khan, Kumar, Sahoo[12] presented the experimental and numerical investigations 

systematically under different categories. 

A comprehensive review of the literature on the flow of various refrigerants through 

the capillary tubes of different geometries viz. straight and coiled and flow configurations 

viz. adiabatic and diabatic, has been discussed in this paper. The paper presents in 

chronological order the experimental and numerical investigations systematically under 

different categories. The paper provides key information about the range of input 

parameters viz. tube diameter, tube length, surface roughness, coil pitch and coil 

diameter, inlet subcooling and condensing pressure or temperature. Other information 

includes type of refrigerants used, correlations proposed and methodology adopted in the 

analysis of flow through the capillary tubes of different geometries operating under 

adiabatic and diabatic flow conditions. It has been found from the review of the literature 

that there is a lot more to investigate for the flow of various refrigerants through different 

capillary tube geometries. 
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2.3 Problem Formulation 

On the basis of the literature survey following points has been taken into account to carry 

out with the present research work. 

1. Despite its simplicity, the capillary tube-suction line heat exchanger is one of the 

most difficult components of the system to design and up to now, 90% of the work 

is concentrated on adiabatic capillary tubes and it is difficult to investigate the two 

phase fluid problems. 

2. Due to the public concerns on the depletion of the ozone layer and global warming, 

CFCs and HCFCs are being phased out from the refrigeration industry and there is a 

need to investigate the flow characteristics of new refrigerants like R-134a. 

3. As stated earlier diabatic capillary tube has advantage over adiabatic capillary tube 

and is mostly used in all the refrigeration systems. 

4. Proper prediction of the capillary tube performance required several preparation 

activities due to the usage of uncommon refrigerants and large number of capillary 

tubes having different dimensions so we will use the software for this. 

5. No work has been reported on the modeling of diabatic capillary tube using the 

commercially available softwares like ANSYS-CFX. 
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Chapter 3 

  

Modeling Procedure 

  
In this chapter, the mathematical model has been developed by applying laws of 

conservation of mass, momentum and energy on capillary tube and compressor suction-

line. The mathematical model obtained is a set of differential equation. A geometric 

model is also developed in Pro-E and solved with Ansys CFX. 

 

3.1 Finite Difference Method 

Finite Difference methods are used to solve differential equations numerically. 

Physical domain is converted to computational domain by discretizing it into a number of 

linear elements. Following steps describe the procedure of solving differential equation. 

– Governing differential equations are obtained by applying the laws of 

conservation of energy momentum and mass. 

– Using finite difference approximation to transform a given differential equations 

into difference equations. 

– Algebraic Equations in nodal unknowns are thus obtained. 

– These simultaneous algebraic equations can be solved by any numerical method. 

– The solution of these algebraic is the solution at the nodes. 

 

The finite difference approximations using Taylor Series 
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Approximation for first Derivative (forward difference formulation) 
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Backward difference formulation 

From equation (2) 
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Central Difference formulation 
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Approximation for second derivative (Central difference formulation) 

Adding Equation (1) and (2) we get 

.......)(
!2

2)(2)()( 0

''
2

000 +
∆

+=∆−+∆+ xf
x

xfxxfxxf
        

(3.5)  

)(0
)()(2)(

)(
2

2

000

0

''
h

x

xxfxfxxf
xf −

∆

∆−+−∆+

≈  

2

11" 2

x

fff
f iii

i
∆

+−

=
−+  

)(0 x∆



16 

 

3.2 Mathematical Modeling  

The diabatic capillary tube of lateral configuration is shown in Fig 3.1. In lateral 

configuration, the capillary tube is brazed on the suction line and then the assembly is 

wrapped with copper tape. The capillary tube is insulated to avoid heat transfer to the 

surroundings. For the purpose of analysis, capillary tube has been divided into three 

regions: the initial adiabatic length (L
in
), the intermediary region length or the heat 

exchange region length (L
hx

), and the final adiabatic length (L
f
).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The developed mathematical model is based on the following assumptions:  

 

– straight, horizontal and constant inner diameter and roughness of the capillary tube  
 

– negligible thermal resistance at the contact of the capillary tube and suction line  

 

– one-dimensional and steady turbulent flow through the capillary tube  

 

– homogenous two-phase flow  

 

– no heat exchange with the surroundings  

 

Capillary tube 

Copper tape 
Brazing joint 

Insulation
Suction line 

Lin Lhx Lf 

Fig. 3.1 Sectional views of diabatic straight capillary tube 
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Table 3.1 shows the governing equations for both capillary tube and suction line fluid 

flow using principle of mass, momentum and energy conservations. 

 

Table 3.1: Governing Equations 

 
Conservation 

 Equations  

Capillary Tube  Suction Line  

Mass    

 
 

 

Momentum  

 
 

 
 

Energy  

 
 

 
 

 

 

 

Heat balance at the tube wall can be expressed by considering the fluid flow in the 

capillary tube and suction line. Therefore, 

=    (3.6) 

 

where, heat transfer coefficients h
c 
and h

s 
can be determined from the following equation: 

       (3.7) 

 

where Nu is the Nusselt number is given by Gnielinski[10] correlation : 

     (3.8) 

 

where, Pr is Prandtl number given by the following relationship: 

       (3.9) 

 

The friction factor f is evaluated using Moody[15] correlation given by 
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   (3.10) 

 

 

For the saturated or superheated vapor flowing through the suction line, neglecting the 

elevation difference and external work in the capillary tube, term   is dropped from 

the energy equation.  

Inside the suction line, thermophysical properties of superheated vapor have not been 

assumed constant and are developed as the function of suction line temperature. For 

different suction line temperatures, thermophysical properties are plotted as a function of 

suction line temperature. The best fit line is fitted and the equation for each 

thermophysical property is derived and then is used in the computer program.  

After the development of mathematical model, as described in the previous section, the 

physical domain shown in Fig. 3.1 is converted into computational domain by 

discretizing the heat exchange region into ‘N’ number of infinitesimal elements of equal 

lengths. The governing differential equations of momentum and energy have been 

converted into the difference equations using forward difference method of the Finite 

Differences. These difference equations have been solved simultaneously to obtain the 

pressure and temperature distribution along the capillary tube. Further, the capillary tube 

lengths in the adiabatic regions of the capillary tube are calculated. In the adiabatic 

regions of the capillary tube, refrigerant temperature is constant when the flow is single 

phase flow while it falls sharply in the two-phase flow.  

Heat exchange process in the single phase flow region   

Fig 3.2 shows the schematic diagram of the capillary tube and suction line heat 

exchanger with the heat transfer starts in the single phase region. As can be seen from the 

figure that refrigerant enters the capillary tube in a subcooled liquid state. There is a drop 

in pressure at the inlet of capillary tube due to sudden contraction. The pressure at point 2 

is given by   

                                      (3.11) 

2

2

74.5

7.3
ln

325.1


























+

=

eR

de

f



19 

 

where k is the entrance loss coefficient and its value has been taken as 1.5. 

 

      

 

 

 

 

 

The pressure drop in the initial length is evaluated using the momentum equation, 

therefore, pressure at point 3 can be written as 

             (3.12) 

Since the flow in the capillary tube is adiabatic in the section 1-3, the refrigerant 

temperature will be constant in section 1-3. 

           (3.13) 

In section 3-4, the flow is diabatic, the temperature will not be constant and will vary 

along the length of capillary tube and in the suction line depending upon the rate of heat 

transfer. Since it is not known where the flash point location will lie in the heat exchange 

region, the single phase heat exchange region has been discretized into a number of 

infinitesimal elements of constant length ( ∆z = z
i+1 

- z
i 
). Therefore, after each elemental 

length, the computer program checks the state of refrigerant. Later on all these 

infinitesimal elements are summed up to get the single phase heat exchange length.  

The pressure after each elemental length can be evaluated by converting the differential 

momentum equation into the difference equation using the forward difference 

formulation as: 

           (3.14) 

 

The refrigerant temperature inside the capillary tube and the suction line can be 

calculated by applying the energy equation (shown in Table 3.1). As the energy equations 

are in differential form, they have been first converted difference equations as follows: 

1, 2 3 4 4s 5 Condenser Evaporator 

Fig. 3.2 Schematic diagram of capillary tube-suction line heat exchanger 
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                          (3.15) 

 

                (3.16) 

 

The wall temperature T
w 

has been calculated by the wall heat balance equation (3.6) as 

follows: 

                                                     (3.17) 

 

 

 

 

 

 

 

 

 

 

 

 

 

The equations (3.15) to (3.17) have been solved simultaneously to obtain the distribution 

of temperature along the capillary tube-suction line heat exchanger. The temperature at 

the end of the heat exchange region i.e., T
4
, will be known in this way. From 4 to 4s the 

single-phase flow is again adiabatic. Therefore, 

                          (3.18) 

Pi Pi+1 

Tci 

Twi 

Tsi 

Tci+1 

Twi+1 

Tsi+1 

Zi Zi+1 

Fig. 3.3 Infinitesimal fluid element in the heat exchange region 
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In the section 4s-5, the flow of refrigerant is two-phase adiabatic flow. This section is 

again discretized into ‘n’ number of infinitesimal elements having constant pressure 

difference across them.  

The pressure at any section ‘i’ is given by 

                          (3.19) 

where, P
4s 

is the saturation pressure corresponding to the refrigerant temperature inside 

the capillary tube at the end heat exchange region, i.e., T
4
. With the pressure P

i 

corresponding quality, x
i
 can be calculated and the entropy at the i-th section can be 

determined from  

                              (3.20) 

The incremental length, dL, is calculated from section after section. For each section, 

pressure, temperature, vapour quality, viscosity, friction factor and entropy are 

calculated. For calculating viscosity McAdams[13] Correlation was used as it gives the 

best two phase length for validation with Ansys CFX. 

 

           (3.21) 

 

  It has been found that the entropy kept on increasing and after attaining certain value it 

started decreasing The calculations are done up to the point of maximum entropy. The 

pressure of the elemental section where entropy is maximum (P
i,smax

), is then compared to 

the evaporator pressure (P
evap

)  

if P
i,smax 

= P
e 
then P

5 
= P

e
 

if P
i,smax 

≠ P
e 
then P

5 
= P

i,smax
 

 

Integrating momentum equation from table 3.1 for the section 4 – 5 

                              (3.22) 

 

The incremental length of each section is calculated using  
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                                 (3.23) 

 

The total length of two-phase region is  

                          (3.24) 

 

The total length of capillary tubes is the sum of single and two-phase lengths, i.e.,  

                  (3.25) 
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No 

Yes 

Following flow chart depicts the step by step procedure followed to obtain results with 

mathematical model. 

  

 

   

  

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Yes 

No 

   Start 

Read inputs p, m, 

dc, ds, tsin, dz, lin, 

lhx, e, t1 

   Calculate p2, re, fsp, p3 

Divide heat exchange region into 

N elements noe = lhx/dz 

Create expressions for capillary 

tube and suction line refrigerant 

properties 

Calculate fsp, fsps, tw,  tsi, tci, pi 

for all elements 

Calculate re, fsp and lsp for 

adiabatic single phase region 

                     ltp+=ltp 

Is s >= smax ? 

Calculate Pi,smax 

Is Pi,smax > Pev 

P5 = Pi,smax 

Calculate Total Length 

L = lsp+lhx+lsp+ltp 

P5 = Pev 

Stop 

Fig. 3.4 Flow Chart for the computation of diabatic capillary length with Mathematical Model 



24 

 

3.3 ANSYS CFX Workflow  

First we need to create the geometry of the model of capillary tube-suction tube 

heat exchanger. So, model it in the Pro Engineer. But for Ansys CFX we also need the 

fluid volume, therefore fill the hollow passages of capillary tube and suction tube with 

fluid volume and saved it in the iges format. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig.3.6 Physical model of capillary tube suction line heat exchanger filled with fluid volume 

Fig.3.5 Physical model of capillary tube suction line heat exchanger 
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Now open the entire assembly in Ansys Workbench Meshing Module. Then opt for CFD 

in the preferences and CFX-Mesh option. In the CFX-Mesh module create the four 

regions namely, in1, in2, out1 and out2 for two inlets and two outlets in the counter flow 

direction. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next create the inflated boundary (0.0001m), which is recommended for analyzing 

pressure drop in narrow hollow pipes. After that specify the Default Body Spacing and 

Default Face Spacing to 0.0003m and generated the volume mesh. Mesh is saved in .gtm 

format. 

 

 

 

 

 

 

Fig.3.7 Mesh of capillary tube suction line heat exchanger model 
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3.3.1 Ansys ICEM CFD 

Alternatively, the mesh can be made in the Ansys ICEM CFD in the same way as 

in CFX-Mesh. This software has a great advantage over the CFX-Mesh, is that it can 

create unstructured mesh. This approach is very useful in our case i.e. meshing of 

capillary tube because the diameter of capillary tube is very small, which poses a great 

problem for CFX-Mesh as it can only decrease the size of the mesh element for adjusting 

to the small size of capillary tube. On the other hand Ansys ICEM CFD can not only 

decrease the size of mesh elements but also the increase the order of mesh elements as 

well as it can create the unstructured mesh. So for all these reasons Ansys ICEM CFD 

takes less time as compared to CFX-Mesh to create the same mesh and the number of 

elements require for meshing also reduces. Thus size of the mesh generated is less as 

compared to CFX-Mesh, this also helps in reducing the time for opening the file in Ansys 

CFX, for solving and for post processing also. 

 

Meshing modules available in Ansys ICEM CFD 

– Tetra 

– Hexa 

– Prism 

– Hybrid meshes 

– Shell meshing 

– Shrinkwrap 

– Patch independent shell meshing 

– Patch based shell meshing 

 

Tetra 

Ansys ICEM CFD Tetra takes full advantage of object-oriented unstructured 

meshing technology. With no tedious up-front triangular surface meshing required 

providing well-balanced start meshes, ANSYS ICEM CFD Tetra works directly from the 

CAD surfaces and fills the volume with tetrahedral elements using the Octree approach. 

A powerful smoothing algorithm provides the element quality. Options are available to 
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automatically refine and coarsen the mesh both on geometry and within the volume. Tetra 

module has been used for mesh generation in this case.  

 

Advantages of Tetra: - 

Intelligent Geometry in ANSYS ICEM CFD Tetra 

 Using ANSYS ICEM CFD’s Direct CAD Interfaces, which maintain the parametric 

description of the geometry throughout the CAD model and the grid generation process, 

unstructured grids can be directly remeshed on the modified geometry.The geometry is 

selected in the CAD system and tagged with information for grid generation such as 

boundary conditions and mesh element sizes. This intelligent geometry information is 

saved with the master geometry. Parametric changes in the geometry simply require the 

user to write the updated geometry file for grid generation. The user can then 

immediately re-calculate the unstructured tetrahedral grids. 

The Octree Approach 

– Tetra’s mesh generation from surfaces is based on the following spatial 

subdivision algorithm: This algorithm ensures refinement of the mesh wherever 

necessary, but maintains larger elements wherever possible, allowing for faster 

computation. 

– Once the “root” tetrahedron, which encloses the entire geometry, has been 

initialized, Tetra subdivides the root tetrahedron until all element size 

requirements are met.  

– At this point, the Tetra mesher balances the mesh so that elements sharing an edge 

or face do not differ in size by more than a factor of 2.  

– After this is done, Tetra makes the mesh conformal – i.e., it guarantees that each 

pair of adjacent elements will share an entire face.    

– The mesh does not yet match the given geometry, so the mesher next rounds the 

nodes of the mesh to the geometry surfaces, curves, and prescribed points.  

– The mesher then determines which portion of the mesh is enclosed by surfaces 

bounding a Body or Material Point (based on mesh connectivity).  The remainder 

of the mesh is deleted. 
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– Finally, the mesh is smoothed by moving nodes (preserving geometry 

associations), merging nodes, swapping edges and in some cases, deleting bad 

elements. 

Parts Creation, Material Points, and Prescribed Points 

The grouping of the geometric entities into parts in the mesher interface allows 

the user to define different parameters on the individual parts. Aside from assigning 

unique boundary condition information to the various parts, the user can also define the 

parameters, which govern the element size for each part: maximum size, initial height 

and height ratio. Additionally, users can define element size on individual curves and 

surfaces. With the definition of prescribed points and curves in the mesher interface, the 

user can control the locations of tetrahedral nodes and edges in critical areas of the mesh. 

As described above in the mesh generation process (The Octree Approach) the mesher 

rounds the nodes of the mesh to match the given geometry, it first tries to project them 

onto the nearest prescribed points and curves. For the cutting step of the mesh generation, 

Tetra requires that a material point be defined for each distinct material that is needed for 

analysis. (The mesher can create these automatically if none are defined.) A material 

point might be used to define a fluid region for CFD analysis, a solid region for FEA 

analysis or both fluid and solid regions for conjugate heat transfer analysis.  

Important Features in ANSYS ICEM CFD Tetra 

Curvature /Proximity Based Refinement 

If the maximum tetrahedral size defined on surface parts is larger than a 

geometric entity in the specified part, the user must employ the Curvature/Proximity 

Based Refinement limit. The user can specify a  size that is proportional to the scale 

factor. It should be assigned a value that is slightly smaller than the smallest gap in the 

model, so that the mesher will further subdivide the tetrahedral to match this geometric 

feature. The Curvature/Proximity Based Refinement is the minimum size of any 

tetrahedral achieved via automatic subdivision for the entire model. If the user defines a 

smaller max element size on a geometry entity, Tetra does continue to subdivide until it 

meets the maximum size request. The effect of the Curvature/Proximity Based 
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Refinement is a geometry-based adaptation of the mesh based on feature curvature and 

proximity. 

Tetrahedral Mesh Smoother 

In smoothing the mesh, the tetrahedral smoother calculates individual element 

quality – based on the selected criterion. Referring then to the user specified element 

quality lower bound, the smoother modifies all elements below this quality criterion --

nodes are moved and merged, edges are swapped and in some cases, elements are 

deleted. This operation is then repeated on the improved grid, up to the specified number 

of iterations. To exclude particular parts from the smoothing, ICEM CFD offers the 

utility to smooth the mesh only on visible parts. Also, the user can smooth only specific 

element without affecting the others 

Tetrahedral Mesh Coarsener 

The mesh coarsener allows the element count to be decreased while still capturing 

the major features of the geometry. Users can choose to freeze surface elements during 

the coarsening process. If the mesh has multiple material domains and the user does not 

want to coarsen some of them, he/she can exclude individual material domains by 

specifying them in the frozen parts option. If the size checks option is used during 

coarsening, the resulting mesh does satisfy the selected mesh size criteria on all of the 

geometric entities. Furthermore, Tetra includes a complete set of projection and 

smoothing tools, as well as tools for element creation, deletion, and splitting, swapping 

and uniform enforcement of orientation. 

Triangular Surface Mesh Smoother 

The triangular surface mesh inherent in the Tetra mesh generation process can 

also be smoothed independently of the volume mesh. The triangular smoother marks all 

elements that are initially below the quality criterion and then runs the specified number 

of smoothing steps on the elements. Nodes are moved on the actual CAD surfaces to 

 improve the aspect ratio of the elements.  

Triangular Surface Mesh Coarsener 

In the interest of minimizing grid points, the coarsener reduces the number of 

triangles in a mesh by merging triangles. This operation is based on the maximum 
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deviation of the resultant triangle center from the surface, the aspect ratio of the merged 

triangle and the maximum size of the merged triangle. 

Triangular Surface Editing Tools 

For the interactive editing of surface meshes, ANSYS ICEM CFD Tetra offers a 

mesh editor in which nodes can be moved on the underlying CAD surfaces, merged, or 

even deleted. Individual triangles of the mesh can be subdivided or added to different 

parts. The user can perform the quality checks, as well as local smoothing. Diagnostic 

tools for surface meshes allow the user to fill holes easily in the surface mesh. Also there 

are tools for the detection of overlapping triangles and non-manifold vertices, as well as 

detection of single/multiple edges and duplicate elements. 

Mesh Periodicity 

Periodicity definition for ANSYS ICEM CFD Tetra meshes is well suited for 

rotating turbomachinery flow solutions. Meshes for any rotational or translational cyclic 

geometry can be generated with ease. 

Mesh Density Control 

The mesh Density definition for ANSYS ICEM CFD Tetra allows users to control 

the tetra size locally where no geometry is present. Densities can be of different shapes: 

point, sphere, line, arbitrary volume. 

Editing the Tetra MeshEditing the Tetra MeshEditing the Tetra MeshEditing the Tetra Mesh    

The two main criteria in validating a Tetra mesh are Check mesh and Smooth mesh 

globally, both of which are found under the Edit mesh menu. 

Check Mesh 

Go to Edit mesh> Check mesh, and press Apply. 

The user can Check/fix each of the problems at this time, or can opt to create subsets for 

each of them so that they can be fixed later. Using subset manipulation and mesh editing 

techniques diagnose the problem and resolve it by merging nodes, splitting edges, 

swapping edges, delete/create elements, etc. 

After eliminating errors/possible problems from a tetra grid, the user needs to smooth the 

grid to improve the quality. To do this, select Edit mesh > Smooth mesh Globally 

Smoothing iterations: This value is the number of times the smoothing process will be 
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performed. Displays with a more complicated geometry will require a greater number of 

iterations to obtain the desired quality, which is assigned in Up to quality.  

Up to quality: As mentioned previously, the Min value represents the worst quality of 

elements, while the Max value represents the highest quality elements. Usually, the Min 

is set at 0.0 and the Max is set at 1.0. The Up to quality value gives the smoother a 

quality to aim for. Ideally, after smoothing, the quality of the elements should be higher 

than or equal to this value. If this does not happen, the user should find other methods of 

improving the quality, such as merging nodes and splitting edges. For most models, the 

elements should all have ratios of greater than 0.3, while a ratio of 0.15 for complicated 

models is usually sufficient.  

Criterion: User can select any criterion to display from pull down menu. 

Smooth: If the Smooth option is toggled on for a particular element type, then this 

element will be smoothed in order to produce a higher grid quality. Element types that 

have the Smooth option selected will have their qualities appear in the associated 

histogram.  

Freeze: If the Freeze option is selected for an element type, the nodes of this element 

type will be fixed during the smoothing operation; thus, the element type will not be 

displayed in the histogram.  

Float: If the Float option is selected for an element type, the nodes of the element type 

are capable of moving freely, allowing nodes that are common with another type of 

element to be smoothed. The nodes of this type of element, however, are not affected 

during the smoothing process and so the quality of these elements is not displayed in the 

histogram.  
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3.3.2 Ansys CFX 

After creating the mesh, open CFX-Pre. Then insert the mesh created before (File 

> Import Mesh). Now we have to import the two materials namely, R-134al (liquid) and 

R-134av (vapour). (Materials > Import Library Data > Browse > Materials-

redkw.ccl). A number of refrigerants are available in the library of Ansys CFX, even if 

the desired refrigerant is not available we can create it by giving the values of different 

variables or an expression for the variable properties (Insert > Material). 

         

 

 

 

      

 

 

 

 

 

 

 

 

 

 

 

The refrigerants which have been imported use Redlich-Kwong equation of state. 

 

 The Redlich-Kwong equation is considered by many to be the best of the two-constant 

equations of state. The Redlich-Kwong equations is somewhat more difficult to 

manipulate mathematically than the van der waals equation, it is more accurate, 

particularly at higher pressures. The two-constant Redlich-Kwong equation performs 

better than some equations of state having several adjustable constants, still, two-constant 

equations of state tend to be limited in accuracy as pressure (or density) increases. 

Fig. 3.8 CFX-Pre window showing different refrigerants available 
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After importing the material we need to create three domains one fluid domain for 

capillary volume, second fluid domain for suction volume and third solid domain for 

copper joint between them. And then we have to set up the physics for solving and post 

processing.  

 

This is how the Ansys CFX-Pre workspace looks like > 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Capillary Domain: 

For creating the domain, click Insert > Domain, give it a name, say capillary. 

We need to fill information written below, some options are the default values and need 

not to change i.e. the only values which need to alter are written below. 

General Options Tab:  

Location > select Capillary 

Domain Type > select Fluid Domain 

Fig.3.9 Mesh of capillary tube suction line heat exchanger in CFX-Pre 
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Fluid List > select r134al, r134av 

Fluid Model Tab: 

Fluid Models > Multiphase Options > Homogenous Model 

Heat Transfer > Option > Fluid Dependent  

Turbulence Model > k-epsilon 

Fluid Details Tab: 

Fluid Details > r134al > Morphology > Continuous Fluid 

Fluid Details > r134al > Heat Transfer > Total Energy 

Fluid Details > r134av > Morphology > Dispersed Fluid 

Fluid Details > r134av > Heat Transfer > Saturation Temperature 

Fluid Pairs Tab: 

Surface Tension Coefficient > 0.00792 N/m (approximate from Ashrae handbook) 

Mass Transfer > Phase Change 

Initialization Tab: 

We need to give the initial guess values of following: 

Initial Conditions > Velocity Type > Cartesian 

Initial Conditions > Cartesian Velocity Components > Options > Automatic with Values 

U > 0 m s^-1 

V > 7 m s^-1 

W > 0 m s^-1 

Static Pressure > Option > Automatic with value 

Static Pressure > Relative Pressure > 900 KPa 

Turbulence Eddy Dissipation > Automatic 

Fluid Specific Information > r134al > Initial conditions > Temperature > 30 c 

Fluid Specific Information > r134al > Initial conditions > Volume Fraction > 1.00 

Fluid Specific Information > r134av > Initial conditions > Temperature > 30 c 

Fluid Specific Information > r134av > Initial conditions > Volume Fraction > 0.00 

 

Solid Domain: 

Fill the following information. 

General Tab: 
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Basic Settings > Location > select the outer body of capillary and the joint between the 

capillary tube and suction line 

Domain Type > Solid Domain 

Solids List > Copper 

Solids Models: 

Heat Transfer > Option > Thermal Energy 

Initialization Tab: 

Initial Conditions > Temperature > 30 c (initial guess) 

 

Suction Domain: 

Fill the following information. 

General Tab: 

Basic Settings > Location > select the suction line 

Domain Type > Fluid Domain 

Fluids List > select r134al, r134av 

Fluid Model Tab: 

Fluid Models > Multiphase Options > Homogenous Model 

Heat Transfer > Option > Fluid Dependent  

Turbulence Model > k-epsilon 

Fluid Details Tab: 

Fluid Details > r134al > Morphology > Continuous Fluid 

Fluid Details > r134al > Heat Transfer > Total Energy 

Fluid Details > r134av > Morphology > Dispersed Fluid 

Fluid Details > r134av > Heat Transfer > Saturation Temperature 

Fluid Pairs Tab: 

Surface Tension Coefficient > 0.00792 N/m (approximate from Ashrae handbook) 

Mass Transfer > Phase Change 

Initialization Tab: 

We need to give the initial guess values of following: 

Initial Conditions > Velocity Type > Cartesian 

Initial Conditions > Cartesian Velocity Components > Options > Automatic with Values 
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U > 0 m s^-1 

V > 1 m s^-1 

W > 0 m s^-1 

Static Pressure >  Option > Automatic with value 

Static Pressure > Relative Pressure > 200 KPa 

Turbulence Eddy Dissipation > Automatic 

Fluid Specific Information > r134al > Initial conditions > Temperature > 10 c 

Fluid Specific Information > r134al > Initial conditions > Volume Fraction > 0.00 

Fluid Specific Information > r134av > Initial conditions > Temperature > 10 c 

Fluid Specific Information > r134av > Initial conditions > Volume Fraction > 1.00 

 

Boundary Conditions: 

Now we need to give boundary conditions for capillary tube and suction line. 

1. Capillary tube: 

There are two boundary conditions for capillary tube, one is inlet, second is outlet. 

A. Inlet: 

Insert > Boundary Condition > Name > in1 

Insert > Boundary Condition > Domain > select Capillary 

Basic Settings Tab: 

Boundary Type > Inlet 

Location > select that face of capillary tube which we want to make the inlet. 

Boundary Details: 

Flow Regime > Subsonic 

Mass and Momentum > Option > Static Pressure > 900 KPa 

Flow Direction > Zero Gradient 

Turbulence > Zero Gradient 

Heat Transfer > Static Temperature > 30 c 

Fluid Values: 

Boundary Conditions > r134al > Volume Fraction > 1.00 

Boundary Conditions > r134av > Volume Fraction > 0.00 

B. Outlet: 
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Insert > Boundary Condition > Name > out1 

Insert > Boundary Condition > Domain > select Capillary 

Basic Settings Tab: 

Boundary Type > Outlet 

Location > select that face of capillary tube which we want to make the outlet. 

Boundary Details: 

Flow Regime > Subsonic 

Mass and Momentum > Option > Relative Pressure > 200 KPa (approximate) 

2. Suction Line: 

There are two boundary conditions for suction line, for inlet and outlet. 

A. Inlet: 

Insert > Boundary Condition > Name > in2 

Insert > Boundary Condition > Domain > select Suction 

Basic Settings Tab: 

Boundary Type > Inlet 

Location > select that face of suction line which we want to make the inlet. 

Boundary Details: 

Flow Regime > Subsonic 

Mass and Momentum > Option > Static Pressure > 200 KPa 

Flow Direction > Zero Gradient 

Turbulence > Zero Gradient 

Heat Transfer > Static Temperature > -10 c 

Fluid Values: 

Boundary Conditions > r134al > Volume Fraction > 0.00 

Boundary Conditions > r134av > Volume Fraction > 1.00 

B. Outlet: 

Insert > Boundary Condition > Name > out2 

Insert > Boundary Condition > Domain > select Suction  

Basic Settings Tab: 

Boundary Type > Outlet 

Location > select that face of suction line which we want to make the outlet. 
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Boundary Details: 

Flow Regime > Subsonic 

Mass and Momentum > Option > Relative Pressure > 150 KPa (approximate) 

 

Interface: 

We need to create two interfaces also, one is between capillary tube and solid copper 

joint and other is between suction line and solid copper joint. To create a domain 

interface click Insert > Domain Interface and give it a name  

 

1. Capillary Tube – Joint Interface: 

Basic Settings Tab: 

Interface Type > Fluid Solid 

Interface Side 1 > Domain (filter) > select capillary 

Interface Side 1 > Region List > select that face of capillary which is opposite to solid 

joint face i.e. which will be responsible for exchange of heat energy with solid joint. 

Interface Side 2 > Domain (filter) > select the solid joint 

Interface Side 2 > Region List > select that face of sold joint which is opposite to above 

selected face of capillary. 

Interface Models > Option > General Connection 

Mesh Connection Method > Automatic 

Boundary Details: 

Boundary Details > Wall Roughness > Rough Wall > 0.003 mm 

Heat Transfer > Conservative Interface Flux 

 

2. Suction Line – Joint Interface: 

Basic Settings Tab: 

Interface Type > Fluid Solid 

Interface Side 1 > Domain (filter) > select suction 

Interface Side 1 > Region List > select that face of suction line which is opposite to solid 

joint face i.e. which will be responsible for exchange of heat energy with solid joint. 

Interface Side 2 > Domain (filter) > select the solid joint 
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Interface Side 2 > Region List > select that face of sold joint which is opposite to above 

selected face of suction. 

Interface Models > Option > General Connection 

Mesh Connection Method > Automatic 

Boundary Details: 

Boundary Details > Wall Roughness > Rough Wall > 0.0003 mm 

Heat Transfer > Conservative Interface Flux 

 

Automatic Wall Boundary Generation: 

The faces which have not been given any boundary condition will be assigned wall 

boundary condition by default that means there is no flow of mass or heat energy. 

 

Now all the physics has been setup, so we can save the CFX-Pre file. File > Save 

Simulation As. For starting the solver, click File > Write Definition File it will 

automatically start the solver. On the right hand side of workspace of Solver, iterations 

will be shown and on the left hand side convergence of different variables (mass, 

momentum, energy, volume fraction etc.) will be shown. When the desired convergence 

is reached, a pop-up menu will be displayed, asking for post-processing of the results, 

click YES to post-process the results. This will open the Post – Processor module of the 

Ansys CFX called CFX-Post. For the purpose of validating the results of our Visual C++ 

Program, we need to create the graphs of different properties like temperature versus 

length, pressure versus length and for that we need to create a Streamline passing through 

the center of the capillary from inlet to outlet.  

Click, Insert > Streamline, give it a name.  

Now click, Domains > select capillary  

Start From > select inlet of capillary tube i.e. in1  

# of Point > 1 

We can select any property to be shown with the help of this streamline using different 

colors to represent the magnitude of that property. To do this, 

Variable > select the desired property  
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Now we need to create the graphs, for that click Insert > Chart, give it a name. On the 

tab of Chart Line, select the following 

 Location > Streamline 

 X Axis > Select the desired property 

 Y Axis > Select the desired property 

Click Apply, and the graph will be shown. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



41 

 

Following flow chart depicts the step by step procedure followed to obtain results with 

Ansys CFX. 
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Chapter 4 

Results and Discussion 

 

4.1 Model Validation 

The results obtained from numerical model, developed for straight capillary tube 

has been validated with the results of Ansys CFX by taking the data of Mendoca et al 

[14]. And the results are in fair agreement with the results of Ansys CFX, which is widely 

used by the industry for CFD analysis. Data input of two cases of Mendoca et al.[14] was 

used as input. 

 

Case 1: 

Refrigerant Used: R-134a 

Mass flow rate: 5.44 kg/hr 

Diameter of Capillary Tube: 0.83 mm 

Diameter of Suction Line: 7.86 mm 

Roughness Ratio: 1.50 µm 

Inlet Suction Line Temperature: 268.15 K 

Adiabatic Capillary Tube Inlet Length: 1.07 m 

Heat Exchanger Length: 1.60 m 

Capillary Tube Inlet Pressure: 0.9 MPa 

Capillary Tube Inlet Temperature: 298 K 

 

Case 2: 

Refrigerant Used: R-134a 

Mass flow rate: 5.37 kg/hr 
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Diameter of Capillary Tube: 0.83 mm 

Diameter of Suction Line: 4.8 mm 

Roughness Ratio: 1.50 µm 

Inlet Suction Line Temperature: 262.05 K 

Adiabatic Capillary Tube Inlet Length: 0.53 m 

Heat Exchanger Length: 1.60 m 

Capillary Tube Inlet Pressure: 0.9 MPa 

Capillary Tube Inlet Temperature: 298 K 

 

Following observations can be made from the results of these two cases: 

In the first case adiabatic capillary tube length is 1.07 m but in the second case it 

is only 0.53 m, which is almost half of the first. In the capillary tube, adiabatic length at 

inlet, refrigerant temperature remains constant because there is no heat exchange with 

surrounding or suction line, and the refrigerant has entered as single phase, and it 

continues to be in single phase throughout the initial adiabatic capillary tube length, so 

that means there is no decrease in temperature of refrigerant. In the heat exchange region 

there is drop in the temperature of refrigerant flowing inside the capillary tube , but the 

temperature of refrigerant, flowing inside the suction line in vapour form, increases 

because of heat exchange with capillary tube. In the last adiabatic region of the capillary 

tube, temperature again becomes constant until the start of two phase or we can say the, 

onset of vaporization. Once the vaporization has started, temperature falls sharply till the 

end of capillary tube length. 

Second difference in these two cases was of suction line inlet temperature, in the 

first case it is more than in the second case i.e. 268.15 K and 262.05 K respectively. 

Therefore, the rate of heat transfer between capillary tube and suction line will be more in 

second case, which is evident from the results.  
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4.2 Graphs 

Following graphs are made from the output of Visual C++ program and graphs 

generated from Ansys CFX and superimposing both in SigmaPlot software. 
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Fig. 4.2 (a) Fig. 4.2 (a) 

Case Case 

Fig. 4.1 (a) 
Fig. 4.1 (b) 
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Case Case 

Fig. 4.3 (a) Fig. 4.3 (b) 

Case Case 

Fig. 4.4 (a) Fig. 4.4 (b) 
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Case Case 

Case Case 

Fig. 4.5 (a) Fig. 4.5 (b) 

Fig. 4.6 (a) Fig. 4.6 (b) 
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Case Case 

Case Case 

Fig. 4.7 (a) Fig. 4.7 (b) 

Fig. 4.8 (a) Fig. 4.8 (b) 
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Case Case 

Case Case 

Fig. 4.9 (a) 
Fig. 4.9 (b) 

Fig. 4.10 (a) Fig. 4.10 (b) 
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Case Case 

Fig. 4.11 (a) 
Fig. 4.11 (b) 
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4.3 Difference between Ansys CFX and Mathematical Model 

– Ansys CFX uses Redlich Kwong equation of state for determining the properties 

of refrigerants whereas proposed mathematical model uses the properties from 

Ashrae Handbook[1], and then creating the expressions for them depending upon 

temperature or pressure and temperature. 

– Ansys CFX is a general software available for CFD analysis whereas our 

mathematical model is written specifically for Diabatic Capillary Tube. 

– Ansys CFX uses turbulence Model (k-ε) but our mathematical model does not, on 

the other hand our mathematical model uses friction factor and viscosity model 

but Ansys CFX does not. 

– Ansys CFX uses FVM (Finite Volume Method) technique but our mathematical 

model uses FDM (Finite Difference Method) technique. 

– Ansys CFX uses the physical (geometric model) model, created in Pro Engineer, 

filled with fluid volume, but our mathematical does not. Result of Ansys CFX 

depends upon the quality of the mesh generated. There may be possible loss of 

geometric information while moving from Pro Engineer to Ansys ICEM CFD and 

from Ansys ICEM CFD to Ansys CFX. There might be some loss of information 

within the three modules of Ansys CFX viz. Pre, Solver and Post Processing. 

  

4.4 Limitations: - 

– Creating the mesh for the size of a capillary tube is very difficult task because of 

the very small diameter and long length. It requires large processing power and lot 

of time. It becomes a iterative process i.e. we have to do a number of meshing 

operations to get a good quality mesh. 

– Solver takes a lot of time and large amount of space is required because for each 

module a different file is made. On an average half GB space is required for one 

solution (one file for Pro-Engineer, one file for Ansys ICEM CFD, one each for 
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Pre, Solver and Post Processor) and one should remember that it is a iterative 

process. 

– There is always a possibility of recondensation of regrigerant inside capillary tube 

if the suction line temperature is sufficiently low. Our model (both) does not 

consider this phenomenon. 

    

4.5 Difference between Adiabatic and Diabatic Capillary Tube 

 

 

 

 

 

 

 

 

 

 

Above figure shows typical temperature profile for adiabatic and diabatic capillary tube. 

Following observations can be made: 

– The temperature profile for adiabatic capillary tube is divided into two regions, 

namely adiabatic single phase region and adiabatic two phase region, shown with 

the help of balloon markings 1, 2 and 3. Refrigerant is in single phase state when 

is between 1 and 2 and is in two phase when is between 2 and 3. Temperature 

remains constant when refrigerant is in single phase as there is no heat exchange 

with surroundings while it decreases sharply when refrigerant starts vaporizing. 

1 2 

3 

1 2 

3 

5 

4 

Fig. 4.12 (a) Fig. 4.12 (b) 
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– The temperature profile for diabatic capillary tube is divided into three regions, 

namely initial adiabatic single phase region, heat exchange region, adiabatic 

single phase region and adiabatic two phase region, shown with the help of 

balloon markings 1, 2, 3, 4 and 5. Refrigerant is in single phase state when is 

between 1 and 4, and is in two phase when is in between 4 and 5. Temperature 

remains constant in initial adiabatic single phase region i.e. between 1 and 2, and 

in adiabatic single phase region i.e. between 3 and 4. Between 2 and 3 is heat 

exchange with suction line which is cold, thus refrigerant losses heat to cold 

suction line and thereby decreasing its temperature. Temperature of suction line 

refrigerant increases. Nearing the end of capillary tube refrigerant starts 

vaporizing, hence the temperature decreases sharply between 4 and 5. 

– In case of diabatic capillary tube, because of heat transfer between capillary tube 

and suction line, refrigerant in capillary tube losses heat to suction line and thus 

the refrigerant coming out of capillary tube will be able extract more heat from 

the evaporator. On the other hand, suction line gains heat from capillary tube and 

thus making the vapour superheated, which is favorable condition at the inlet of 

compressor because it increases the life by eliminating the probability of moisture 

entering the compressor. 

 

4.6 Concluding Remarks 

For Ansys CFX, first a physical (geometric) model is made in the Pro-Engineer, filled 

with fluid volume, then a mesh is generated in the Ansys ICEM CFD, and then this 

mesh is imported in Ansys CFX Pre. Then refrigerant R-134a is imported from its 

library and three domains are made for capillary tube, suction line and for joint between 

them. All the boundary and initial conditions are given, two interface were made 

between capillary tube and joint, and suction tube joint. After that solver starts and the 

solution is post processed.  

In case of mathematical model of diabatic capillary tube, laws of conservation of mass, 

momentum and energy are used and lateral arrangement for capillary tube – suction 
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line counter flow heat exchange region is used. The differential equations are converted 

into difference equations using forward difference formulation of Finite Difference 

Approximations. The solution is obtained by solving these difference equations 

simultaneously. The numerical data has been validated with the results from Ansys 

CFX.   

 

4.7 Future Scope 

– The phenomenon for recondensation and metastability should be incorporated for 

future research work on the development of mathematical model for diabatic 

capillary tubes. 

– Commercial software packages like Ansys ICEM CFD, Ansys CFX-Mesh should 

have separate algorithm for meshing of capillary sized small cylindrical pipes, 

which at present is very difficult work. 

– Friction factor and viscosity model should be incorporated into commercial 

softwares for solution of capillary tube. 
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Appendix 

 

A.1 Visual C++ Codes 

 

Case 1: 

 // Diabatic.cpp : Defines the entry point for the console application. 

  

#include "stdafx.h" 

 ofstream fout("output.txt"); 

 ofstream gout("output2.txt"); 

 void main() 

 { 

  cout<<"\nProgram for Diabatic Capillary Tube"<<endl; 

  double p1=900000,p2,p3,t1=25+273,t3,kloss=1.5,lin=1.07,lhx=1.60, 

lf=1.33,tsub=10,tci1,tci2,pi1,pi2,dc=0.83/1000,ds=7.86/1000, 

mfc=5.44/3600,vol=0.00082772,gc,gs,ac,as,res,fsps,vol2,ktc,ktcs,t4,p4, 

t4s,p4s, fsp,dz=0.1,rough=0.001807,re,rho=1208.1,vel,vis=0.00019575, 

noe,vels,rhos=26.934,pr,nu,hc,hs,nus,prs,enc=241720,visc=0.00018349, 

cpc=1445.1,cps=994.76,viss=0.000011448,tsi1=273+19.1,tsi2,tw,dx=0.0; 

 

 //--------------------------------------------- 

 //Single-Phase Adiabatic Region 

 //--------------------------------------------- 

 

fout<<setprecision(8)<<setiosflags(ios::showpoint)<<"\n0.00"<<"\t\t"<<p1<<"\t"  

        <<t1; 

 ac=3.14*dc*dc/4;     

 as=3.14*ds*ds/4;     

 gc=mfc/ac;       

 vel=gc/rho;   fout<<"\t"<<vel;      

 gs=mfc/as;       

  vels=gs/rhos;      
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 p2=p1-kloss*gc*gc*vol/2;   

 re=rho*vel*dc/vis;  fout<<"\t"<<re;     

 fsp=1.325/pow(log((rough/3.7)+(5.74/pow(re,0.9))),2); fout<<"\t"<<fsp;  

 fout<<"\t"<<rho<<"\t"<<vol<<"\t"<<vis<<"\t"<<enc; 

 p3=p2-fsp*vol*gc*gc*lin/(2*dc);     

fout<<"\n"<<lin<<"\t"<<p3; 

 t3=t1;    fout<<"\t"<<t3<<endl; 

  

//--------------------------------------------- 

 //Single-Phase Heat-Exchange (Diabatic) Region 

 //--------------------------------------------- 

 

 pi1=p3; tci1=t3; noe=lhx/dz;      

       

 for(int j=1;j<=noe;j++) 

 { 

 rho=exp(11.9599)*pow(tci1,-0.8592)*pow(pi1,0.0024);  

 visc=exp(12.2525)*pow(tci1,-3.6728)*pow(pi1,0.0097);  

 vol2=1/rho;           

 if(j==1) { vol=vol2; } 

 cpc=exp(2.9543)*pow(tci1,0.7642)*pow(pi1,-0.0036);   

 ktc=exp(6.0522)*pow(tci1,-1.5147)*pow(pi1,0.0050);  

 pr=cpc*visc/ktc;          

 enc=exp(2.0523)*pow(tci1,1.8094)*pow(pi1,0.0004);   

 vel=gc/rho;           

 re=gc*dc/visc;           

 fsp=1.325/pow(log((rough/3.7)+(5.74/pow(re,0.9))),2);   

 nu=(fsp/8)*(re-1000)*pr/(1+12.7*sqrt(fsp/8)*(pow(pr,2/3)-1));  

 hc=nu*ktc/dc;           

 rhos=-0.4836*tsi1+0.0020*tsi1*tsi1;    

 cps=1.6849*tsi1+0.0059*tsi1*tsi1;    

 viss=4.0863E-008*tsi1-5.7686E-012*tsi1*tsi1;  

 ktcs=-3.0583E-006*tsi1+1.6569E-007*tsi1*tsi1;   

 prs=cps*viss/ktcs;          
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 vels=gs/rhos;           

 res=gs*ds/viss;          

 fsps=1.325/pow(log((rough/3.7)+(5.74/pow(res,0.9))),2);   

 nus=(fsps/8)*(res-1000)*prs/(1+12.7*sqrt(fsps/8)*(pow(prs,2/3)-1));  

 hs=nus*ktcs/ds;          

 tw=(hc*dc*tci1+hs*ds*tsi1)/(hc*dc+hs*ds);    

 tsi2=tsi1-(hs*3.141*ds*(tw-tsi1)*dz/(mfc*cps));   

 tci2=tci1-(hc*3.14*dc*(tci1-tw)*dz)/(mfc*cpc)-gc*gc*(vol2*vol2-vol*vol)/(2);  

 pi2=pi1-(fsp*gc*gc*vol*dz)/(2*dc)-(gc*gc*(vol2-vol));  

 tsi1=tsi2; tci1=tci2;    

 pi1=pi2; vol=vol2;  dx+=dz; 

 fout<<"\n"<<lin+dx<<"\t"<<pi2<<"\t"<<tci2<<"\t"<<vel<<"\t"<<re<<"\t"<<fsp; 

 fout<<"\t"<<rho<<"\t"<<vol2<<"\t"<<visc<<"\t"<<enc; 

 } 

  

 //------------------------------- 

 //Adiabatic Single-Phase Region 

 //------------------------------- 

 

 t4=tci2; p4=pi2;   

 t4s=t4;  p4s=400940; 

 double rho4=1265,lsp; 

 vis=0.00023839; 

 vel=gc/rho4;       

 re=rho4*vel*dc/vis;      

 fsp=1.325/pow(log((rough/3.7)+(5.74/pow(re,0.9))),2);   

 lsp=2*dc*rho4*(p4-p4s)/(fsp*gc*gc);    

 fout<<"\n\n"<<lin+dx<<"\t"<<p4<<"\t"<<t4<<"\t"<<vel<<"\t"<<re<<"\t"<<fsp 

       <<"\t"<<rho4; 

fout<<"\n"<<lin+dx+lsp<<"\t"<<p4s<<"\t"<<t4s<<"\t"<<vel<<"\t"<<re<<"\t" 

       <<fsp<<"\t"<<rho4<<endl; 

  

     //-------------------------------------- 

 //Adiabatic Two-Phase Region 
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 //-------------------------------------- 

  

 double dp=1000,p,rhof,rhog,rhofg,hf,hg,hfg,sf,sg,sfg,muf,mug,mutp, 

vf,vg,vfg,s=0,smax=0,oldrho,h4s=212210,t,x=0,v,velocity, 

reytp,ftp,dl,ltp=0,y,h; 

  

rho=rho4; 

 int i=1; 

 do 

 { 

p=p4s-dp;      

  s=smax; oldrho=rho;     

  t=247.8017+8.6019E-005*p;  

  vf=0.0007+1.7510E-010*p;  rhof=1/vf; 

  vg=0.1230-1.8317E-007*p;  vfg=vg-vf;  rhog=1/vg; 

  rhofg=rhog-rhof; 

  hf=165913.8436+0.1164*p; 

  hg=384092.9375+0.0495*p;  hfg=hg-hf; 

  sf=877.5165+0.0004*p; 

  sg=1740.1162-4.4446E-005*p;  sfg=sg-sf; 

  muf=0.0003-2.7942E-010*p; 

  mug=9.7920E-006+3.1888E-012*p; 

  y=pow(((gc*gc*vf*vfg)+hfg),2)-2*gc*gc*vfg*vfg*((-h4s+hf) 

    +((gc*gc*vf*vf)/2)-((vel*vel)/2)); 

  x=(-hfg-gc*gc*vf*vfg+sqrt(y))/(gc*gc*vfg*vfg);   

  mutp=mug*muf/(x*muf+(1-x)*mug);  

  v=vf+x*vfg;       

  rho=1/v;  

  if(i==1) 

  { 

   oldrho=rho; 

  } i++;  

  velocity=mfc/(ac*rho);     

  smax=sf+x*sfg;   
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  h=hf+x*hfg; 

  reytp=velocity*dc/(mutp*v); 

  ftp=1.325/pow(log(rough/3.7+5.74/pow(reytp,0.9)),2); 

  dl=fabs((2*dc/ftp)*(((-rho*dp)/(gc*gc))+((oldrho-rho)/(rho))));  

  p4s=p; 

 

  ltp+=dl;   

fout<<"\n"<<lin+dx+lsp+ltp<<"\t"<<p<<"\t"<<t<<"\t"<<velocity 

       <<"\t"<<reytp<<"\t"<<ftp<<"\t"<<rho<<"\t"<<v<<"\t" 

       <<mutp<<"\t"<<h<<"\t"<<x<<"\t"<<smax; 

 }while(s<smax && t>264); 

 getch(); 

 } 
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Case 2: 

 

// Diabatic.cpp : Defines the entry point for the console application. 

  

#include "stdafx.h" 

 ofstream fout("output.txt"); 

 ofstream gout("output2.txt"); 

 

 void main() 

 { 

  cout<<"\nProgram for Diabatic Capillary Tube"<<endl; 

 

  double p1=900000,p2,p3,t1=25+273,t3,kloss=1.5,lin=0.53,lhx=1.60, 

tsub=10.5,tci1,tci2,pi1,pi2,dc=0.83/1000,ds=4.8/1000, 

mfc=5.37/3600,vol=0.00082733,gc,gs,ac,as,res,fsps,vol2, 

ktc,ktcs,t4,p4,t4s,p4s,fsp,dz=0.1,rough=0.001807,re, 

rho=1208.7,vel,vis=0.00019612,noe,vels,rhos=27.652,pr, 

nu,hc,hs,nus,prs,enc=234340,visc=0.00019586,cpc=1422.0, 

cps=999.77,viss=0.000011482,tsi1=273+21,tsi2,tw,dx=0.00; 

 

 //--------------------------------------------- 

 //Single-Phase Adiabatic Region 

 //--------------------------------------------- 

 fout<<setprecision(8)<<setiosflags(ios::showpoint)<<"\n0.00"<<"\t\t"<<p1<<"\t"     

       <<t1; 

 ac=3.14*dc*dc/4;     

 as=3.14*ds*ds/4;     

 gc=mfc/ac;       

 vel=gc/rho;   fout<<"\t"<<vel;      

 gs=mfc/as;       

  vels=gs/rhos;      

 p2=p1-kloss*gc*gc*vol/2;   

 re=rho*vel*dc/vis;  fout<<"\t"<<re;     

 fsp=1.325/pow(log((rough/3.7)+(5.74/pow(re,0.9))),2); fout<<"\t"<<fsp; 
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 fout<<"\t"<<rho<<"\t"<<vol<<"\t"<<vis<<"\t"<<enc; 

 p3=p2-fsp*vol*gc*gc*lin/(2*dc);    

 fout<<"\n"<<lin<<"\t"<<p3; 

 t3=t1;    fout<<"\t"<<t3<<endl; 

  

 //--------------------------------------------- 

 //Single-Phase Heat-Exchange (Diabatic) Region 

 //--------------------------------------------- 

 

 pi1=p3; tci1=t3; noe=lhx/dz;      

      

 for(int j=1;j<=noe;j++) 

 { 

  rho=exp(11.9599)*pow(tci1,-0.8592)*pow(pi1,0.0024);  

  visc=exp(12.2525)*pow(tci1,-3.6728)*pow(pi1,0.0097);  

  vol2=1/rho;         

  if(j==1) { vol=vol2; } 

  cpc=exp(2.9543)*pow(tci1,0.7642)*pow(pi1,-0.0036);   

  ktc=exp(6.0522)*pow(tci1,-1.5147)*pow(pi1,0.0050);  

  pr=cpc*visc/ktc; 

  enc=exp(2.0523)*pow(tci1,1.8094)*pow(pi1,0.0004);   

  vel=gc/rho;  

  re=gc*dc/visc;  

  fsp=1.325/pow(log((rough/3.7)+(5.74/pow(re,0.9))),2);   

  nu=(fsp/8)*(re-1000)*pr/(1+12.7*sqrt(fsp/8)*(pow(pr,2/3)-1));  

  hc=nu*ktc/dc;  

  rhos=-0.4836*tsi1+0.0020*tsi1*tsi1;    

  cps=1.6849*tsi1+0.0059*tsi1*tsi1;    

  viss=4.0863E-008*tsi1-5.7686E-012*tsi1*tsi1;  

  ktcs=-3.0583E-006*tsi1+1.6569E-007*tsi1*tsi1;   

  prs=cps*viss/ktcs; 

  vels=gs/rhos;  

  res=gs*ds/viss; 

  fsps=1.325/pow(log((rough/3.7)+(5.74/pow(res,0.9))),2);   
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  nus=(fsps/8)*(res-1000)*prs/(1+12.7*sqrt(fsps/8)*(pow(prs,2/3)-1));  

  hs=nus*ktcs/ds; 

  tw=(hc*dc*tci1+hs*ds*tsi1)/(hc*dc+hs*ds);    

  tsi2=tsi1-(hs*3.141*ds*(tw-tsi1)*dz/(mfc*cps));   

  tci2=tci1-(hc*3.14*dc*(tci1-tw)*dz)/(mfc*cpc) 

        -gc*gc*(vol2*vol2-vol*vol)/(2);  

  pi2=pi1-(fsp*gc*gc*vol*dz)/(2*dc)-(gc*gc*(vol2-vol));  

  tsi1=tsi2; tci1=tci2;    

  pi1=pi2; vol=vol2;  dx+=dz; 

  fout<<"\n"<<lin+dx<<"\t"<<pi2<<"\t"<<tci2<<"\t"<<vel 

       <<"\t"<<re<<"\t"<<fsp; 

  fout<<"\t"<<rho<<"\t"<<vol2<<"\t"<<visc<<"\t"<<enc; 

 } 

  

 //------------------------------- 

 //Adiabatic Single-Phase Region 

 //------------------------------- 

 

 t4=tci2; p4=pi2;   

 t4s=t4;  p4s=345740; 

 double rho4=1279.2,lsp; 

 vis=0.00025114; 

 vel=gc/rho4;       

 re=rho4*vel*dc/vis;      

 fsp=1.325/pow(log((rough/3.7)+(5.74/pow(re,0.9))),2);   

 lsp=2*dc*rho4*(p4-p4s)/(fsp*gc*gc);    

 fout<<"\n\n"<<lin+dx<<"\t"<<p4<<"\t"<<t4<<"\t"<<vel<<"\t"<<re 

       <<"\t"<<fsp<<"\t"<<rho4; 

 fout<<"\n"<<lin+dx+lsp<<"\t"<<p4s<<"\t"<<t4s<<"\t"<<vel<<"\t" 

       <<re<<"\t"<<fsp<<"\t"<<rho4<<endl; 

  

            //-------------------------------------- 

 //Adiabatic Two-Phase Region 

 //-------------------------------------- 



61 

 

  

 double dp=1000,p,rhof,rhog,rhofg,hf,hg,hfg,sf,sg,sfg,muf,mug,mutp, 

            vf,vg,vfg,s=0,smax=0,oldrho,h4s=206310,t,x=0,v,velocity, 

reytp,ftp,dl,ltp=0,y,h; 

  

 rho=rho4; 

 int i=1; 

 do 

 { 

  p=p4s-dp;      

  s=smax; oldrho=rho;     

  t=247.8017+8.6019E-005*p;  

  vf=0.0007+1.7510E-010*p;  rhof=1/vf; 

  vg=0.1230-1.8317E-007*p;  vfg=vg-vf;  rhog=1/vg; 

  rhofg=rhog-rhof; 

  hf=165913.8436+0.1164*p; 

  hg=384092.9375+0.0495*p;  hfg=hg-hf; 

  sf=877.5165+0.0004*p; 

  sg=1740.1162-4.4446E-005*p;  sfg=sg-sf; 

  muf=0.0003-2.7942E-010*p; 

  mug=9.7920E-006+3.1888E-012*p; 

  y=pow(((gc*gc*vf*vfg)+hfg),2)-2*gc*gc*vfg*vfg*((-h4s+hf) 

    +((gc*gc*vf*vf)/2)-((vel*vel)/2)); 

  x=(-hfg-gc*gc*vf*vfg+sqrt(y))/(gc*gc*vfg*vfg);   

  mutp=mug*muf/(x*muf+(1-x)*mug);  

  v=vf+x*vfg;       

  rho=1/v;  

  if(i==1) 

  { 

   oldrho=rho; 

  } i++;  

  velocity=mfc/(ac*rho);     

  smax=sf+x*sfg;   

  h=hf+x*hfg; 
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  reytp=velocity*dc/(mutp*v); 

  ftp=1.325/pow(log(rough/3.7+5.74/pow(reytp,0.9)),2); 

  dl=fabs((2*dc/ftp)*(((-rho*dp)/(gc*gc))+((oldrho-rho)/(rho))));  

  p4s=p; 

  ltp+=dl;   

  fout<<"\n"<<lin+dx+lsp+ltp<<"\t"<<p<<"\t"<<t<<"\t"<<velocity 

       <<"\t"<<reytp<<"\t"<<ftp<<"\t"<<rho<<"\t"<<v<<"\t"<<mutp<<"\t" 

       <<h<<"\t"<<x<<"\t"<<smax; 

 }while(s<smax+0.5 && t>264); 

 getch(); 

 } 
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A.2 Data Generated 

 

 

Lengt

h 

   Pressure     Temp    Vel   Rey No        f Densit

y 

Volu

me 

Viscos

ity 

Enthal

py 

     x Entropy

0 900000 298 2.313 11848.05 0.032

7 

1208.1 8.28E-

04 

1.96E-

04 

234340 0 1119 

1.07 758774.57 298 2.313 11848.05 0.032

7 

1207.9 8.28E-

04 

1.96E-

04 

234340 0 1119 

1.17 746041.39 297.310

7 

2.311

5 

11869.15

8 

0.032

7 

1208.8

83 

8.27E-

04 

1.95E-

04 

234693.

8 

0 1119 

1.27 733299.19 296.599

9 

2.307 11770.57

2 

0.032

8 

1211.2

41 

8.26E-

04 

1.97E-

04 

233710.

9 

0 1119 

1.37 720559.86 295.854

5 

2.302

3 

11669.48

8 

0.032

8 

1213.6

85 

8.24E-

04 

1.99E-

04 

232699.

2 

0 1119 

1.47 707823.24 295.073

1 

2.297

4 

11564.11 0.032

9 

1216.2

6 

8.22E-

04 

2.01E-

04 

231640.

6 

0 1119 

1.57 695089.38 294.253

7 

2.292

3 

11454.30

6 

0.033 1218.9

75 

8.20E-

04 

2.02E-

04 

230533.

1 

0 1119 

1.67 682358.34 293.394

3 

2.287 11339.90

9 

0.033 1221.8

38 

8.18E-

04 

2.05E-

04 

229374.

3 

0 1119 

1.77 669630.15 292.492
8 

2.281
3 

11220.75
3 

0.033
1 

1224.8
58 

8.16E-
04 

2.07E-
04 

228161.
9 

0 1119 

1.87 656904.84 291.546

8 

2.275

4 

11096.66

5 

0.033

2 

1228.0

46 

8.14E-

04 

2.09E-

04 

226893.

3 

0 1119 

1.97 644182.44 290.554

2 

2.269

2 

10967.47

2 

0.033

3 

1231.4

11 

8.12E-

04 

2.11E-

04 

225565.

6 

0 1119 

2.07 631462.96 289.512

2 

2.262

6 

10832.99

9 

0.033

3 

1234.9

67 

8.10E-

04 

2.14E-

04 

224176.

1 

0 1119 

2.17 618746.38 288.418

3 

2.255

8 

10693.06

8 

0.033

4 

1238.7

26 

8.07E-

04 

2.17E-

04 

222721.

8 

0 1119 

2.27 606032.69 287.269

6 

2.248

6 

10547.50

3 

0.033

5 

1242.7

01 

8.05E-

04 

2.20E-

04 

221199.

7 

0 1119 

2.37 593321.84 286.063

1 

2.241 10396.12

6 

0.033

6 

1246.9

07 

8.02E-

04 

2.23E-

04 

219606.

3 

0 1119 

2.47 580613.76 284.795

6 

2.233 10238.76

2 

0.033

7 

1251.3

61 

7.99E-

04 

2.27E-

04 

217938.

4 

0 1119 

2.57 567908.36 283.463

7 

2.224

6 

10075.23

9 

0.033

9 

1256.0

79 

7.96E-

04 

2.30E-

04 

216192.

4 

0 1119 

2.67 555205.52 282.063

9 

2.215

8 

9905.391 0.034 1261.0

81 

7.93E-

04 

2.39E-

04 

214364.

6 

0 1119 

2.670

1 

555205.52 282.063

9 

2.208

9 

9728.83 0.034

1 

1265 7.90E-

04 

2.39E-

04 

212120 0 1042.

9 

3.885

9 

400940 282.063

9 

2.208

9 

9728.83 0.034

1 

1265 7.90E-

04 

2.39E-

04 

212120 0 1042.

9 

3.914

7 

396940 281.946

1 

2.216

9 

12360.68

9 

0.032

5 

1260.4

56 

7.93E-

04 

1.88E-

04 

212210 4.82E-

04 

1036.

62 

3.920 395940 281.860 2.300 12462.35 0.032 1214.4 8.23E- 1.86E- 212209. 1.09E- 1036.

Table 5.1: Properties as calculated by Visual C++ Program 

Case 1: 
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7 1 8 9 4 73 04 04 8 03 64 

3.926

5 

394940 281.774 2.385

3 

12564.08

6 

0.032

4 

1171.4

53 

8.54E-

04 

1.85E-

04 

212209.

6 

1.69E-

03 

1036.

66 

3.932

2 

393940 281.688 2.470

4 

12665.86

9 

0.032

3 

1131.1

23 

8.84E-

04 

1.83E-

04 

212209.

4 

2.30E-

03 

1036.

67 

3.937

6 

392940 281.602 2.556 12767.70

8 

0.032

3 

1093.2

4 

9.15E-

04 

1.82E-

04 

212209.

2 

2.90E-

03 

1036.

69 

3.942

8 

391940 281.516 2.642

1 

12869.60

1 

0.032

2 

1057.5

91 

9.46E-

04 

1.80E-

04 

212209 3.51E-

03 

1036.

71 

3.947

9 

390940 281.43 2.728

8 

12971.54

9 

0.032

2 

1023.9

86 

9.77E-

04 

1.79E-

04 

212208.

7 

4.11E-

03 

1036.

72 

3.952
8 

389940 281.344 2.816
1 

13073.55
2 

0.032
1 

992.25
6 

1.01E-
03 

1.77E-
04 

212208.
5 

4.71E-
03 

1036.
74 

3.957

6 

388940 281.257

9 

2.903

9 

13175.60

8 

0.032

1 

962.25

06 

1.04E-

03 

1.76E-

04 

212208.

2 

5.32E-

03 

1036.

76 

3.962

2 

387940 281.171

9 

2.992

3 

13277.71

8 

0.032 933.83

47 

1.07E-

03 

1.75E-

04 

212208 5.92E-

03 

1036.

78 

3.966

7 

386940 281.085

9 

3.081

2 

13379.88

1 

0.032 906.88

71 

1.10E-

03 

1.73E-

04 

212207.

7 

6.52E-

03 

1036.

8 

3.971

1 

385940 280.999

9 

3.170

6 

13482.09

6 

0.031

9 

881.29

84 

1.13E-

03 

1.72E-

04 

212207.

4 

7.12E-

03 

1036.

81 

3.975

3 

384940 280.913

9 

3.260

7 

13584.36

4 

0.031

9 

856.97 1.17E-

03 

1.71E-

04 

212207.

1 

7.72E-

03 

1036.

83 

3.979

4 

383940 280.827

8 

3.351

2 

13686.68

3 

0.031

8 

833.81

24 

1.20E-

03 

1.69E-

04 

212206.

8 

8.32E-

03 

1036.

85 

3.983

4 

382940 280.741

8 

3.442

3 

13789.05

4 

0.031

8 

811.74

44 

1.23E-

03 

1.68E-

04 

212206.

5 

8.92E-

03 

1036.

87 

3.987

3 

381940 280.655

8 

3.534 13891.47

5 

0.031

7 

790.69

22 

1.26E-

03 

1.67E-

04 

212206.

2 

9.52E-

03 

1036.

89 

3.991

1 

380940 280.569

8 

3.626

2 

13993.94

7 

0.031

7 

770.58

84 

1.30E-

03 

1.66E-

04 

212205.

9 

0.010

1 

1036.

91 

3.994

9 

379940 280.483

8 

3.718

9 

14096.47 0.031

6 

751.37

16 

1.33E-

03 

1.65E-

04 

212205.

5 

0.010

7 

1036.

93 

3.998
5 

378940 280.397
7 

3.812
2 

14199.04
2 

0.031
6 

732.98
53 

1.36E-
03 

1.63E-
04 

212205.
2 

0.011
3 

1036.
95 

4.002 377940 280.311

7 

3.906 14301.66

3 

0.031

6 

715.37

79 

1.40E-

03 

1.62E-

04 

212204.

8 

0.011

9 

1036.

97 

4.005

4 

376940 280.225

7 

4.000

4 

14404.33

3 

0.031

5 

698.50

18 

1.43E-

03 

1.61E-

04 

212204.

4 

0.012

5 

1036.

99 

4.008

8 

375940 280.139

7 

4.095

3 

14507.05

2 

0.031

5 

682.31

34 

1.47E-

03 

1.60E-

04 

212204.

1 

0.013

1 

1037.

01 

4.012

1 

374940 280.053

7 

4.190

8 

14609.81

9 

0.031

4 

666.77

22 

1.50E-

03 

1.59E-

04 

212203.

7 

0.013

7 

1037.

03 

4.015

3 

373940 279.967

6 

4.286

8 

14712.63

4 

0.031

4 

651.84

12 

1.53E-

03 

1.58E-

04 

212203.

3 

0.014

3 

1037.

05 

4.018

4 

372940 279.881

6 

4.383

3 

14815.49

6 

0.031

3 

637.48

58 

1.57E-

03 

1.57E-

04 

212202.

8 

0.014

9 

1037.

07 

4.021

5 

371940 279.795

6 

4.480

4 

14918.40

5 

0.031

3 

623.67

41 

1.60E-

03 

1.55E-

04 

212202.

4 

0.015

5 

1037.

1 

4.024

5 

370940 279.709

6 

4.578 15021.36 0.031

3 

610.37

65 

1.64E-

03 

1.54E-

04 

212202 0.016

1 

1037.

12 

4.027

4 

369940 279.623

6 

4.676

1 

15124.36

2 

0.031

2 

597.56

54 

1.67E-

03 

1.53E-

04 

212201.

5 

0.016

7 

1037.

14 
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4.030

3 

368940 279.537

6 

4.774

8 

15227.40

9 

0.031

2 

585.21

54 

1.71E-

03 

1.52E-

04 

212201 0.017

3 

1037.

16 

4.033

1 

367940 279.451

5 

4.874 15330.50

1 

0.031

1 

573.30

25 

1.74E-

03 

1.51E-

04 

212200.

6 

0.017

9 

1037.

18 

4.035

8 

366940 279.365

5 

4.973

8 

15433.63

9 

0.031

1 

561.80

46 

1.78E-

03 

1.50E-

04 

212200.

1 

0.018

5 

1037.

21 

4.038

5 

365940 279.279

5 

5.074

1 

15536.82

1 

0.031

1 

550.70

09 

1.82E-

03 

1.49E-

04 

212199.

6 

0.019

1 

1037.

23 

4.041

1 

364940 279.193

5 

5.174

9 

15640.04

8 

0.031 539.97

19 

1.85E-

03 

1.48E-

04 

212199.

1 

0.019

6 

1037.

25 

4.043
7 

363940 279.107
4 

5.276
2 

15743.31
8 

0.031 529.59
96 

1.89E-
03 

1.47E-
04 

212198.
5 

0.020
2 

1037.
27 

4.046

3 

362940 279.021

4 

5.378

1 

15846.63

1 

0.031 519.56

69 

1.92E-

03 

1.46E-

04 

212198 0.020

8 

1037.

3 

4.048

7 

361940 278.935

4 

5.480

5 

15949.98

8 

0.030

9 

509.85

79 

1.96E-

03 

1.45E-

04 

212197.

4 

0.021

4 

1037.

32 

4.051

2 

360940 278.849

4 

5.583

5 

16053.38

7 

0.030

9 

500.45

75 

2.00E-

03 

1.44E-

04 

212196.

9 

0.022 1037.

34 

4.053

6 

359940 278.763

4 

5.686

9 

16156.82

8 

0.030

8 

491.35

19 

2.04E-

03 

1.44E-

04 

212196.

3 

0.022

6 

1037.

37 

4.055

9 

358940 278.677

4 

5.790

9 

16260.31

2 

0.030

8 

482.52

76 

2.07E-

03 

1.43E-

04 

212195.

7 

0.023

2 

1037.

39 

4.058

2 

357940 278.591

3 

5.895

5 

16363.83

6 

0.030

8 

473.97

22 

2.11E-

03 

1.42E-

04 

212195.

1 

0.023

8 

1037.

42 

4.060

5 

356940 278.505

3 

6.000

5 

16467.40

2 

0.030

7 

465.67

41 

2.15E-

03 

1.41E-

04 

212194.

4 

0.024

4 

1037.

44 

4.062

7 

355940 278.419

3 

6.106

1 

16571.00

9 

0.030

7 

457.62

21 

2.19E-

03 

1.40E-

04 

212193.

8 

0.024

9 

1037.

46 

4.064

9 

354940 278.333

3 

6.212

2 

16674.65

6 

0.030

7 

449.80

58 

2.22E-

03 

1.39E-

04 

212193.

1 

0.025

5 

1037.

49 

4.067 353940 278.247

3 

6.318

8 

16778.34

3 

0.030

6 

442.21

53 

2.26E-

03 

1.38E-

04 

212192.

5 

0.026

1 

1037.

51 

4.069
1 

352940 278.161
3 

6.426 16882.06
9 

0.030
6 

434.84
13 

2.30E-
03 

1.37E-
04 

212191.
8 

0.026
7 

1037.
54 

4.071

2 

351940 278.075

2 

6.533

7 

16985.83

5 

0.030

6 

427.67

5 

2.34E-

03 

1.37E-

04 

212191.

1 

0.027

3 

1037.

56 

4.073

2 

350940 277.989

2 

6.641

9 

17089.63

9 

0.030

5 

420.70

8 

2.38E-

03 

1.36E-

04 

212190.

4 

0.027

9 

1037.

59 

4.075

2 

349940 277.903

2 

6.750

6 

17193.48

3 

0.030

5 

413.93

23 

2.42E-

03 

1.35E-

04 

212189.

7 

0.028

5 

1037.

61 

4.077

1 

348940 277.817

2 

6.859

8 

17297.36

4 

0.030

5 

407.34

06 

2.45E-

03 

1.34E-

04 

212188.

9 
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64 

4.079

1 

347940 277.731

2 

6.969

6 
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3 
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4 
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56 
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03 
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04 
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6 
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9 
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4 
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03 
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04 
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4 

0.030

2 

1037.

69 
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8 
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1 
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7 
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2 

0.030

4 
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92 

2.57E-

03 
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04 

212186.

6 

0.030

8 

1037.

72 
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7 

344940 277.473

1 
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2 

0.030

3 
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52 
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03 
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04 

212185.

8 
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4 

1037.
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5 
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3 
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13 

2.73E-
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04 
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3 

0.033

1 

1037.
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7 
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2 
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6 
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9 
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6 
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03 
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04 
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7 
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3 
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9 
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5 

0.030
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04 
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7 
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9 
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9 
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9 
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8 

0.030

1 

335.57

12 

2.98E-

03 

1.24E-

04 

212177.

8 
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6 

1037.

99 

4.101

5 

334940 276.612

9 

8.443

4 

18755.49

4 

0.030

1 
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34 

3.02E-

03 

1.24E-

04 

212176.

8 

0.037

2 
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9 
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3 
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3 

0.03 326.42

2 

3.06E-

03 

1.23E-

04 

212175.

8 
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7 
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05 

4.104

6 
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9 
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8 
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4 
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37 

3.11E-

03 
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04 
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8 
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3 
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08 
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1 
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9 
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8 
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6 
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03 
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04 

212173.

8 
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9 
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5 
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8 
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2 
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1 
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9 
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3 
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03 
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04 
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7 
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5 
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04 
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8 
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7 
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8 
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04 
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8 

1038.
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7 
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04 
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9 
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7 
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6 
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6 
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8 
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04 
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04 
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7 
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3 
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7 
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03 
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04 

212162.

4 
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6 
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4 
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2 
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6 
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7 
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4 
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7 
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5 
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03 
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04 

212161.

2 
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2 
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43 

4.122

5 
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6 
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1 
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3 

0.029

7 
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75 

3.67E-

03 
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04 

212159.

9 

0.045

8 
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46 

4.123

8 
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6 

10.37

5 
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8 

0.029

6 
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69 

3.71E-

03 
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04 

212158.

6 

0.046

3 
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49 
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6 
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1 
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6 
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13 
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03 
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04 
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3 
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9 
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52 
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2 
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6 
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6 
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6 
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03 
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04 
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5 
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2 
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7 

0.029

6 
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78 
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04 
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6 
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5 
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8 
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04 
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6 
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62 
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8 
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5 
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5 
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7 
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5 
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03 
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04 
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9 
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2 
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9 
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5 
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2 
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5 
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3.98E-

03 
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04 

212150.

5 

0.049

7 
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68 
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5 
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8 

0.029

5 
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48 
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03 
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04 

212149 0.050

3 
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71 

4.133
2 
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5 

11.38
9 

21269.50
1 

0.029
4 

245.35
66 

4.08E-
03 

1.09E-
04 

212147.
6 

0.050
9 

1038.
74 

4.134

3 

309940 274.462

4 

11.51

8 

21374.58

8 

0.029

4 

242.61

06 

4.12E-

03 

1.09E-

04 

212146.

1 

0.051

4 

1038.

77 

4.135

4 

308940 274.376

4 

11.64

7 

21479.69

9 

0.029

4 

239.91

52 

4.17E-

03 

1.08E-

04 

212144.

6 

0.052 1038.

81 

4.136

5 

307940 274.290

4 

11.77

7 

21584.83

3 

0.029

4 

237.26

93 

4.21E-

03 

1.07E-

04 

212143.

1 

0.052

6 

1038.

84 

4.137

6 

306940 274.204

4 

11.90

7 

21689.99

1 

0.029

3 

234.67

15 

4.26E-

03 

1.07E-

04 

212141.

6 

0.053

1 

1038.

87 

4.138

7 

305940 274.118

4 

12.03

8 

21795.17

2 

0.029

3 

232.12

06 

4.31E-

03 

1.06E-

04 

212140 0.053

7 

1038.

9 

4.139

7 

304940 274.032

3 

12.16

9 

21900.37

6 

0.029

3 

229.61

55 

4.36E-

03 

1.06E-

04 

212138.

4 

0.054

3 

1038.

94 

4.140

7 

303940 273.946

3 

12.30

1 

22005.60

2 

0.029

3 

227.15

49 

4.40E-

03 

1.05E-

04 

212136.

8 

0.054

8 

1038.

97 

4.141

8 

302940 273.860

3 

12.43

4 

22110.85 0.029

3 

224.73

77 

4.45E-

03 

1.05E-

04 

212135.

1 

0.055

4 

1039 

4.142

8 

301940 273.774

3 

12.56

6 

22216.11

9 

0.029

2 

222.36

3 

4.50E-

03 

1.04E-

04 

212133.

5 

0.055

9 

1039.

04 

4.143

8 

300940 273.688

3 

12.7 22321.41 0.029

2 

220.02

95 

4.54E-

03 

1.04E-

04 

212131.

8 

0.056

5 

1039.

07 

4.144
8 

299940 273.602
2 

12.83
3 

22426.72
2 

0.029
2 

217.73
64 

4.59E-
03 

1.03E-
04 

212130.
1 

0.057
1 

1039.
1 

4.145

7 

298940 273.516

2 

12.96

8 

22532.05

5 

0.029

2 

215.48

26 

4.64E-

03 

1.03E-

04 

212128.

4 

0.057

6 

1039.

14 

4.146

7 

297940 273.430

2 

13.10

2 

22637.40

8 

0.029

1 

213.26

72 

4.69E-

03 

1.02E-

04 

212126.

6 

0.058

2 

1039.

17 

4.147

6 

296940 273.344

2 

13.23

8 

22742.78

1 

0.029

1 

211.08

93 

4.74E-

03 

1.02E-

04 

212124.

8 

0.058

7 

1039.

2 

4.148

6 

295940 273.258

2 

13.37

3 

22848.17

4 

0.029

1 

208.94

79 

4.79E-

03 

1.02E-

04 

212123 0.059

3 

1039.

24 

4.149

5 

294940 273.172

1 

13.50

9 

22953.58

6 

0.029

1 

206.84

23 

4.83E-

03 

1.01E-

04 

212121.

2 

0.059

8 

1039.

27 

4.150

4 

293940 273.086

1 

13.64

6 

23059.01

7 

0.029

1 

204.77

16 

4.88E-

03 

1.01E-

04 

212119.

3 

0.060

4 

1039.

31 

4.151

4 

292940 273.000

1 

13.78

3 

23164.46

7 

0.029 202.73

49 

4.93E-

03 

1.00E-

04 

212117.

5 

0.061 1039.

34 

4.152

3 

291940 272.914

1 

13.92

1 

23269.93

6 

0.029 200.73

15 

4.98E-

03 

9.97E-

05 

212115.

6 
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5 

1039.

37 
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1 

290940 272.828

1 
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9 
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2 
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06 
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03 
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05 
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6 
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1 

1039.

41 

4.154 289940 272.742 14.19 23480.92 0.029 196.82 5.08E- 9.88E- 212111. 0.062 1039.
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4.154

9 

288940 272.656 14.33

6 

23586.44

8 

0.029 194.91

36 

5.13E-

03 

9.83E-

05 

212109.

7 
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2 

1039.

48 

4.155

8 

287940 272.57 14.47

6 

23691.98

7 

0.028

9 

193.03

59 

5.18E-

03 
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05 
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7 
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7 

1039.

51 

4.156

6 

286940 272.484 14.61

5 

23797.54

2 

0.028

9 
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8 

5.23E-

03 
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05 
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6 
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3 

1039.
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6 

23903.11

5 

0.028

9 
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91 

5.28E-

03 
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05 
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6 
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8 

1039.

58 
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3 

284940 272.312 14.89

7 
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3 

0.028

9 
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86 

5.33E-

03 
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05 
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5 
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4 

1039.
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9 
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8 

24114.30
7 

0.028
9 

185.81
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9 

1039.
65 
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9 

282940 272.139

9 
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7 

0.028

8 

184.08

02 

5.43E-

03 
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05 
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2 
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5 

1039.

69 

4.160

7 
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9 
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2 
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2 

0.028

8 
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13 

5.48E-

03 
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05 

212095.

1 

0.067 1039.

72 

4.161

5 

280940 271.967

9 

15.46

5 

24431.21

2 

0.028

8 
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83 

5.53E-

03 

9.49E-

05 

212092.

9 

0.067

6 

1039.

76 

4.162

3 
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9 

15.60

8 

24536.87

6 

0.028

8 
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08 

5.59E-

03 

9.45E-

05 

212090.

6 
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1 

1039.

8 
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1 
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8 
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2 
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0.028

8 
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82 
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03 

9.41E-

05 
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4 
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7 
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9 
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8 

15.89

6 
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7 
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01 
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03 
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05 
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2 
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87 
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6 
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8 
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7 
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8 
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8 
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9 
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4 
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8 
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5 
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7 
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49 
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03 

9.29E-

05 
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5 
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3 

1039.
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1 
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4 
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7 
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260940 270.247

5 

18.41

5 

26546.87

2 

0.028

5 

151.73

95 

6.59E-

03 

8.74E-

05 

212042.

9 

0.078

5 

1040.

5 

4.176

5 

259940 270.161

5 

18.56

7 

26652.76

4 

0.028

4 

150.49

52 

6.64E-

03 

8.70E-

05 

212040.

1 

0.079 1040.

54 

4.177

1 

258940 270.075

5 

18.72 26758.66

5 

0.028

4 

149.26

76 

6.70E-

03 

8.67E-

05 

212037.

2 

0.079

6 

1040.

57 

4.177
7 

257940 269.989
4 

18.87
3 

26864.57
4 

0.028
4 

148.05
64 

6.75E-
03 

8.63E-
05 

212034.
3 

0.080
1 

1040.
61 

4.178

4 

256940 269.903

4 

19.02

7 

26970.49

1 

0.028

4 

146.86

12 

6.81E-

03 

8.60E-

05 

212031.

4 

0.080

6 

1040.

65 

4.179 255940 269.817

4 

19.18

1 

27076.41

5 

0.028

4 

145.68

19 

6.86E-

03 

8.57E-

05 

212028.

5 

0.081

2 

1040.

69 

4.179

6 

254940 269.731

4 

19.33

5 

27182.34

5 

0.028

4 

144.51

8 

6.92E-

03 

8.53E-

05 

212025.

5 

0.081

7 

1040.

73 

4.180

2 

253940 269.645

4 

19.49 27288.28

3 

0.028

3 

143.36

93 

6.98E-

03 

8.50E-

05 

212022.

5 

0.082

3 

1040.

77 

4.180

8 

252940 269.559

4 

19.64

6 

27394.22

7 

0.028

3 

142.23

56 

7.03E-

03 

8.47E-

05 

212019.

5 

0.082

8 

1040.

8 

4.181

4 

251940 269.473

3 

19.80

1 

27500.17

8 

0.028

3 

141.11

65 

7.09E-

03 

8.43E-

05 

212016.

4 

0.083

3 

1040.

84 

4.182 250940 269.387

3 

19.95

8 

27606.13

4 

0.028

3 

140.01

19 

7.14E-

03 

8.40E-

05 

212013.

3 

0.083

9 

1040.

88 

4.182

6 

249940 269.301

3 

20.11

4 

27712.09

6 

0.028

3 

138.92

14 

7.20E-

03 

8.37E-

05 

212010.

2 

0.084

4 

1040.

92 

4.183

1 

248940 269.215

3 

20.27

1 

27818.06

3 

0.028

3 

137.84

47 

7.25E-

03 

8.34E-

05 

212007 0.084

9 

1040.

96 

4.183

7 

247940 269.129

3 

20.42

9 

27924.03

5 

0.028

2 

136.78

17 

7.31E-

03 

8.31E-

05 

212003.

8 

0.085

5 

1041 

4.184
3 

246940 269.043
2 

20.58
7 

28030.01
3 

0.028
2 

135.73
22 

7.37E-
03 

8.27E-
05 

212000.
5 

0.086 1041.
04 

4.184

8 

245940 268.957

2 

20.74

5 

28135.99

4 

0.028

2 

134.69

58 

7.42E-

03 

8.24E-

05 

211997.

3 

0.086

5 

1041.

08 

4.185

4 

244940 268.871

2 

20.90

4 

28241.98 0.028

2 

133.67

23 

7.48E-

03 

8.21E-

05 

211994 0.087

1 

1041.

12 

4.186 243940 268.785

2 

21.06

3 

28347.96

9 

0.028

2 

132.66

15 

7.54E-

03 

8.18E-

05 

211990.

6 

0.087

6 

1041.

16 

4.186

5 

242940 268.699

2 

21.22

3 

28453.96

3 

0.028

2 

131.66

33 

7.60E-

03 

8.15E-

05 

211987.

2 

0.088

1 

1041.

2 

4.187 241940 268.613

1 

21.38

3 

28559.95

9 

0.028

2 

130.67

73 

7.65E-

03 

8.12E-

05 

211983.

8 

0.088

7 

1041.

23 

4.187

6 

240940 268.527

1 

21.54

4 

28665.95

9 

0.028

1 

129.70

34 

7.71E-

03 

8.09E-

05 

211980.

4 

0.089

2 

1041.

27 

4.188

1 

239940 268.441

1 

21.70

5 

28771.96

1 

0.028

1 

128.74

14 

7.77E-

03 

8.06E-

05 

211976.

9 

0.089

7 

1041.

31 

4.188

6 

238940 268.355

1 

21.86

6 

28877.96

6 

0.028

1 

127.79

1 

7.83E-

03 

8.03E-

05 

211973.

4 

0.090

2 

1041.

35 

4.189

2 

237940 268.269

1 

22.02

8 

28983.97

3 

0.028

1 

126.85

22 

7.88E-

03 

8.00E-

05 

211969.

8 

0.090

8 

1041.

39 

4.189 236940 268.183 22.19 29089.98 0.028 125.92 7.94E- 7.97E- 211966. 0.091 1041.
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7 2 1 46 03 05 2 3 43 

4.190

2 

235940 268.097 22.35

3 

29195.99

2 

0.028

1 

125.00

81 

8.00E-

03 

7.94E-

05 

211962.

6 

0.091

8 

1041.

47 

4.190

7 

234940 268.011 22.51

6 

29302.00

4 

0.028

1 

124.10

25 

8.06E-

03 

7.92E-

05 

211959 0.092

4 

1041.

51 

4.191

2 

233940 267.925 22.68 29408.01

7 

0.028 123.20

76 

8.12E-

03 

7.89E-

05 

211955.

3 

0.092

9 

1041.

55 

4.191

7 

232940 267.839 22.84

3 

29514.03

1 

0.028 122.32

33 

8.18E-

03 

7.86E-

05 

211951.

5 

0.093

4 

1041.

59 

4.192

2 

231940 267.753 23.00

8 

29620.04

6 

0.028 121.44

94 

8.23E-

03 

7.83E-

05 

211947.

8 

0.093

9 

1041.

63 

4.192
7 

230940 267.666
9 

23.17
3 

29726.06 0.028 120.58
57 

8.29E-
03 

7.80E-
05 

211944 0.094
5 

1041.
67 

4.193

2 

229940 267.580

9 

23.33

8 

29832.07

5 

0.028 119.73

2 

8.35E-

03 

7.77E-

05 

211940.

1 

0.095 1041.

71 

4.193

7 

228940 267.494

9 

23.50

4 

29938.08

9 

0.028 118.88

82 

8.41E-

03 

7.75E-

05 

211936.

2 

0.095

5 

1041.

75 

4.194

1 

227940 267.408

9 

23.67 30044.10

3 

0.028 118.05

42 

8.47E-

03 

7.72E-

05 

211932.

3 

0.096 1041.

8 

4.194

6 

226940 267.322

9 

23.83

6 

30150.11

6 

0.027

9 

117.22

97 

8.53E-

03 

7.69E-

05 

211928.

4 

0.096

5 

1041.

84 

4.195

1 

225940 267.236

8 

24.00

3 

30256.12

8 

0.027

9 

116.41

46 

8.59E-

03 

7.67E-

05 

211924.

4 

0.097

1 

1041.

88 

4.195

5 

224940 267.150

8 

24.17 30362.13

9 

0.027

9 

115.60

88 

8.65E-

03 

7.64E-

05 

211920.

3 

0.097

6 

1041.

92 

4.196 223940 267.064

8 

24.33

8 

30468.14

8 

0.027

9 

114.81

22 

8.71E-

03 

7.61E-

05 

211916.

3 

0.098

1 

1041.

96 

4.196

5 

222940 266.978

8 

24.50

6 

30574.15

5 

0.027

9 

114.02

45 

8.77E-

03 

7.59E-

05 

211912.

2 

0.098

6 

1042 

4.196

9 

221940 266.892

8 

24.67

5 

30680.15

9 

0.027

9 

113.24

57 

8.83E-

03 

7.56E-

05 

211908 0.099

2 

1042.

04 

4.197

4 

220940 266.806

7 

24.84

4 

30786.16

2 

0.027

9 

112.47

56 

8.89E-

03 

7.53E-

05 

211903.

8 

0.099

7 

1042.

08 

4.197
8 

219940 266.720
7 

25.01
3 

30892.16
2 

0.027
9 

111.71
4 

8.95E-
03 

7.51E-
05 

211899.
6 

0.100
2 

1042.
12 

4.198

3 

218940 266.634

7 

25.18

3 

30998.15

8 

0.027

8 

110.96

09 

9.01E-

03 

7.48E-

05 

211895.

4 

0.100

7 

1042.

16 

4.198

7 

217940 266.548

7 

25.35

3 

31104.15

2 

0.027

8 

110.21

61 

9.07E-

03 

7.46E-

05 

211891.

1 

0.101

2 

1042.

2 

4.199

1 

216940 266.462

7 

25.52

3 

31210.14

2 

0.027

8 

109.47

95 

9.13E-

03 

7.43E-

05 

211886.

7 

0.101

7 

1042.

24 

4.199

6 

215940 266.376

6 

25.69

4 

31316.12

8 

0.027

8 

108.75

09 

9.20E-

03 

7.41E-

05 

211882.

3 

0.102

3 

1042.

29 

4.2 214940 266.290

6 

25.86

6 

31422.11 0.027

8 

108.03

03 

9.26E-

03 

7.38E-

05 

211877.

9 

0.102

8 

1042.

33 

4.200

4 

213940 266.204

6 

26.03

8 

31528.08

8 

0.027

8 

107.31

75 

9.32E-

03 

7.36E-

05 

211873.

5 

0.103

3 

1042.

37 

4.200

8 

212940 266.118

6 

26.21 31634.06

1 

0.027

8 

106.61

24 

9.38E-

03 

7.33E-

05 

211869 0.103

8 

1042.

41 

4.201

3 

211940 266.032

6 

26.38

2 

31740.02

9 

0.027

8 

105.91

49 

9.44E-

03 

7.31E-

05 

211864.

4 

0.104

3 

1042.

45 

4.201

7 

210940 265.946

6 

26.55

5 

31845.99

3 

0.027

7 

105.22

49 

9.50E-

03 

7.28E-

05 

211859.

9 

0.104

8 

1042.

49 
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4.202

1 

209940 265.860

5 

26.72

9 

31951.95

1 

0.027

7 

104.54

22 

9.57E-

03 

7.26E-

05 

211855.

2 

0.105

3 

1042.

53 

4.202

5 

208940 265.774

5 

26.90

3 

32057.90

3 

0.027

7 

103.86

68 

9.63E-

03 

7.23E-

05 

211850.

6 

0.105

9 

1042.

57 

4.202

9 

207940 265.688

5 

27.07

7 

32163.85 0.027

7 

103.19

86 

9.69E-

03 

7.21E-

05 

211845.

9 

0.106

4 

1042.

62 

4.203

3 

206940 265.602

5 

27.25

1 

32269.79 0.027

7 

102.53

74 

9.75E-

03 

7.19E-

05 

211841.

1 

0.106

9 

1042.

66 

4.203

7 

205940 265.516

5 

27.42

6 

32375.72

4 

0.027

7 

101.88

31 

9.82E-

03 
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05 
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0.107

4 

1042.

7 
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204940 265.430
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27.60
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74 
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202940 265.258
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05 

211811.
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05 

211806.

8 
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4 
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29.91
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211748.
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0.116 1043.
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Lengt

h 

Pressure Temp Vel Rey No f Density Volume Viscosit

y 

Enthal

py 

x s 

0.0000 900000.0

000 

298.00

00 

2.282

1 

11673.5

290 

0.032

8 

1208.70

00 

8.2733e

-4 

1.9612e

-4 

234340.

0000 

0.00

00 

1118.6 

0.5300 829286.5

500 

298.00

00 

2.282

1 

11673.5

290 

0.032

8 

1208.70

00 

8.2733e

-4 

1.9612e

-4 

234340.

0000 

0.00

00 

1118.6 

0.6300 816846.7

200 

297.29

08 

2.281

2 

11706.3

350 

0.032

8 

1209.14

07 

8.2703e

-4 

1.9557e

-4 

234702.

0900 

0.00

00 

1118.6 

0.7300 804397.6

700 

296.54

26 

2.276

6 

11606.0

470 

0.032

9 

1211.57

45 

8.2537e

-4 

1.9726e

-4 

233691.

0700 

0.00

00 

1118.6 

0.8300 791951.1

600 

295.73

99 

2.271

8 

11500.8

340 

0.032

9 

1214.15

59 

8.2362e

-4 

1.9906e

-4 

232626.

4800 

0.00

00 

1118.6 

0.9300 779507.0

700 

294.87

86 

2.266

6 

11388.6

230 

0.033

0 

1216.94

15 

8.2173e

-4 

2.0103e

-4 

231486.

8500 

0.00

00 

1118.6 

1.0300 767065.4

800 

293.95

42 

2.261

0 

11269.0

120 

0.033

1 

1219.94

85 

8.1971e

-4 

2.0316e

-4 

230267.

0100 

0.00

00 

1118.6 

1.1300 754626.4
600 

292.96
18 

2.255
0 

11141.5
490 

0.033
2 

1223.19
67 

8.1753e
-4 

2.0548e
-4 

228961.
1100 

0.00
00 

1118.6 

1.2300 742190.0

800 

291.89

58 

2.248

6 

11005.7

600 

0.033

2 

1226.70

80 

8.1519e

-4 

2.0802e

-4 

227562.

8300 

0.00

00 

1118.6 

1.3300 729756.3

600 

290.75

05 

2.241

6 

10861.1

510 

0.033

3 

1230.50

68 

8.1267e

-4 

2.1079e

-4 

226065.

4000 

0.00

00 

1118.6 

1.4300 717325.3

200 

289.51

95 

2.234

2 

10707.2

090 

0.033

4 

1234.62

02 

8.0997e

-4 

2.1382e

-4 

224461.

5100 

0.00

00 

1118.6 

1.5300 704896.9

500 

288.19

57 

2.226

1 

10543.4

000 

0.033

5 

1239.07

82 

8.0705e

-4 

2.1714e

-4 

222743.

3100 
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Table 5.2: Properties as calculated by Visual C++ Program 

Case 2: 
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